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Predslov
Geografické informačné systémy (GIS) ako technologický prostriedok pozostávajú 

z niekoľkých komponentov. Ich vzájomná kombinácia vytvára typ informačného systému, 
resp. technológie, ktorou dokážeme riešiť rôzne priestorové problémy. V tejto učebnici sa 
budeme venovať GIS softvérovému vybaveniu, ktorému mnohí autori prikladajú najväčšiu 
váhu, alebo ho nazývajú aj jadrom celého systému.

Na trhu existuje množstvo rôznych GIS softvérových produktov od viacerých producen-
tov, ktoré majú lokálne, ale aj globálne zázemie. GIS softvérové produkty sa distribuujú na 
komerčnej báze alebo na báze slobodného šírenia. Rôznorodosť GIS softvérových produk-
tov je iniciátorom neustáleho vylepšovania ich používateľského prostredia a funkcionality. 
Lídrom medzi softvérovými producentmi je spoločnosť ESRI z USA, ktorá na trh priniesla 
systém ArcGIS. Ide o súbor produktov určených na komplexné nasadenie GIS v akejkoľvek 
oblasti a úrovni. Súčasťou ArcGIS systému sú stolné (desktopové), serverové a vývojárske 
produkty, riešenia pre mobilné zariadenia a špecializované nadstavby. Systém ArcGIS je na-
vrhnutý tak, aby bolo možné uplatňovať základné princípy práce s GIS, ale aj všeobecne 
zaužívané štandardy informačných technológií. Všetky produkty (aplikácie) systému Arc-
GIS sú zostavené z tzv. modulárnych softvérových komponentov, ktoré je možné využívať 
v desktopových, ale aj serverových riešeniach. Zároveň možno tieto modulárne komponen-
ty prispôsobovať podľa požiadaviek používateľov. Aktuálnou verziou systému je ArcGIS 
10.x, ktorá ponúka inovácie vo všetkých oblastiach využívania GIS, t. j. od vizualizácie až po 
webové služby. 

V tejto vysokoškolskej učebnici sa budeme zaoberať obsluhou ArcGIS Desktop ako GIS 
systému, ktorý je určený na osobné použitie. Rozsah funkcionality je viazaný na licenčný 
typ Advanced, ktorým je možné profesionálne vytvárať, editovať, spracovať a vizualizovať 
geografické informácie. Pri tomto licenčnom type môžeme využívať profesionálne nástro-
je určené na priestorové analýzy javov a problémov súvisiacich s krajinnou sférou, resp. 
priestorom na a v okolí zemského povrchu. 

Prioritná a najrozsiahlejšia kapitola učebnice je zameraná na tvorbu geografických infor-
mácií. Spektrum informácií, ktoré je z nej možné získať, je východiskom pre vlastnú tvor-
bu geografických informácií a máp, pre priestorové analýzy, riešenia problémov viazaných 
na priestor atď.

Predpokladáme, že používatelia učebnice už majú určitú predstavu o GIS. Pomocou 
učebnice sa však naučia obsluhovať konkrétny GIS softvérový produkt tak, aby boli schopní 
tieto vedomosti a zručnosti aplikovať pri riešení konkrétnych problémov súvisiacich s kra-
jinnou sférou.

Autori
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1 . Softvérový systém ArcGIS
ArcGIS je softvérový systém, ktorý umožňuje používateľom zhromažďovať, organizovať, 

riadiť, analyzovať a distribuovať geografické informácie. Ide o poprednú svetovú platformu 
práce s GIS. Systém je k dispozícii vo forme on-line internetových aplikácií, produktov pre 
mobilné telefóny resp. smartfóny, servery a osobné počítače. ArcGIS je tvorený sériou rôz-
nych produktov prepojených do jedného pracovného prostredia, ktoré ponúka nasledovné 
možnosti:

Vytvárať mapy  • – mapy predstavujú efektívny spôsob organizovania, uchovania, po-
chopenia a šírenia priestorových údajov. ArcGIS umožňuje vytvárať rôzne typy sta-
tických a dynamických máp, ktoré sú určené napr. pre internetové aplikácie, mobilné 
zariadenia, veľkoplošné tlačiarne atď. Mapa je v ArcGISe vnímaná ako interaktívne 
okno, kde používateľ zobrazuje, skúma, analyzuje a aktualizuje geografické informá-
cie.

Vytvárať geografické informácie  • – so zameraním na profesionálnu tvorbu geogra-
fických informácií.

Ukladať, spravovať a manažovať geografické informácie  • – databázy geografických 
informácií (geodatabázy) predstavujú jeden z najviac žiadaných komponentov GIS. 
Geodatabázy poskytujú štruktúrovaný priestor na uloženie, spravovanie a šírenie 
geografických informácií. ArcGIS ponúka rôzne typy databázových systémov, napr. 
Oracle, SQL Server, PostgreSQL, Informix, DB2, personal geodatabase .mdb atď. Zá-
roveň vytvára kompatibilné prostredie toku dát medzi uvedenými systémami. 

Riešiť priestorové problémy  • – priestorové analýzy na základe vstupných informácií 
vytvárajú nové dátové komplexy (syntetické informácie). Syntetickými informáciami 
je možné lepšie a efektívnejšie riešiť rôzne priestorové problémy.

Vytvárať mapové aplikácie  • – z mapových výstupov vytvárať funkčné informačné 
systémy resp. aplikácie, napr. mapu počasia, turistické mapy, katastrálne mapy atď. 
ArcGIS zároveň poskytuje aj priestor na tvorbu špecifických aplikácií so zameraním 
na podporu procesu riešenia rôznych priestorových problémov, napr. mapy rizika 
vzniku povodní, zosuvov atď. 

Komunikovať a distribuovať GIS produkty  • – vzájomná komunikácia medzi použí-
vateľmi s priestorom na šírenie vytvorených GIS produktov. Ide o silné komunikačné 
a sociálne rozhranie v oblasti GIS. Prostredníctvom tohto typu rozhrania sa bežní 
používatelia stávajú profesionálnymi pracovníkmi GIS.

ArcGIS systém je tvorený nasledovným súborom komponentov, resp. samostatných soft-
vérových produktov:

1 . ArcGIS Desktop – GIS softvérový produkt určený pre osobné počítače s operač-
ným systémom Windows. Softvérový produkt umožňuje tvorbu, priestorové analý-
zy, vizua lizáciu geografických informácií atď. ArcGIS Desktop sa distribuuje v troch 
rôznych licenciách (Basic, Standard a Advanced). Každá licencia poskytuje inú úro-
veň funkcionality. Ďalšími nadstavbami (extensions) sa rozširuje napr. o priestorové 
analýzy geografických informácií v rastrovom dátovom formáte (Spatial Analyst), 
o 3D vizualizáciu geografických informácií (3D Analyst), geoštatistiku (Geostatisti-
cal Analyst) atď. ArcGIS Desktop je softvérový produkt určený koncovým GIS pra-
covníkom. 
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2 . ArcGIS Server – GIS softvérový produkt, ktorý umožňuje tvorbu, analýzu, správu 
a vizualizáciu geografických informácií na centralizovanej úrovni v on-line prostredí 
a pre rôzne formy používateľských rozhraní. Súčasťou ArcGIS Servera sú nástroje na 
vývoj GIS mobilných a webových aplikácií.

3 . ArcGIS Online (http://www.arcgis.com) – GIS v cloud systéme, ktorý poskytuje naj-
rôznejšie služby v internetovom prostredí, napr. úložné miesto, tvorbu interaktívnych 
máp a aplikácií, rôzne mapové služby atď. Dôraz sa kladie na intuitívne prostredie, 
sociálne a komunikačné rozhranie. Súčasťou ArcGIS Online je široké spektrum zá-
kladných máp od spoločnosti ESRI a mapových produktov od používateľskej komu-
nity. 

4 . ArcGIS Mobile – GIS softvérový produkt v prenosných, vreckových počítačoch 
a mobilných telefónoch, ktorý umožňuje zber a aktualizáciu údajov priamo v terén-
nom prostredí. Terénny zber môže byť prepojený so službami, ktoré poskytuje Arc-
GIS Server.

5 . ArcGIS Explorer – GIS softvérový produkt na báze GPL/GNU licencií, ktoré umož-
ňujú pracovať s pripravenými GIS produktmi .

Developer tools/Nástroje pre vývojárov 6 . – nástroje určené na úpravu funkcionality 
systému ArcGIS.

Špeciálne riešenia pre rôzne odvetvia priemyslu 7 . – okrem štandardných a bežných 
používateľských produktov sú k dispozícii aj špeciálne riešenia využiteľné v rôznych 
odvetviach hospodárstva. Ide napr. o logistiku v doprave, o riešenia v plavebnej a ná-
mornej správe, o prácu s armádnymi údajmi, riešenia pre geoportály atď.

Obrázkové a textové informácie uvádzané v tejto kapitole sú čerpané z rôznych zdrojov. 
Medzi hlavné zdroje patrí:

oficiálna webová stránka spoločnosti ESRI  http://www.esri.com [cit. 06/2013]; •

Boltižiar, M. (2007):  • Geografické informačné systémy pre geografov I. 1. vyd. Nitra : 
Fakulta prírodných vied Univerzity Konštantína Filozofa v Nitre, 2007. Vysokoškol-
ské skriptum. 96 s. ISBN 9788080941963;

Boltižiar, M. – Vojtek, M. (2009):  • Geografické informačné systémy pre geografov II. 1. 
vyd. Nitra : Fakulta prírodných vied Univerzity Konštantína Filozofa v Nitre, 2009. 
Vysokoškolské skriptum. 140 s. + CD-ROM príloha. ISBN 9788080945534. 
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2 . Práca s ArcMap
Táto kapitola je zameraná na predstavenie aplikácie ArcMap. Ide o hlavnú aplikáciu soft-

vérového produktu ArcGIS Desktop 10.2. Aplikácia ArcMap umožňuje vytvárať geografické 
informácie, mapy, pracovať s databázovým rozhraním, priestorovými analýzami atď.

2 .1 . Spustenie aplikácie ArcMap
Po spustení aplikácie ArcMap sa zobrazí dialógové okno s názvom 1 . ArcMap – Getting 
Started. Prostredníctvom tohto dialógového okna môžeme otvoriť rozpracovaný 
mapový dokument, alebo založiť nový mapový dokument podľa preddefinovaných 
šablón či bez tzv. šablónových parametrov. 

V ďalšej časti okna sú uvedené adresárové cesty a cieľová geodatabáza, do ktorej sa 2 . 
budú ukladať všetky vytvorené dáta.

K mapovému dokumentu máme možnosť priradiť geodatabázu ako priestor, kde sa 3 . 
ukladá obsah našej práce. V dialógovom okne nie je možné upraviť jej obsah, názov, 
ani jej umiestnenie. Jedinou dostupnou operáciou je len výber z vopred vytvorených 
geodatabáz, z ktorých jedna sa pre ďalšiu prácu stane predvolenou. ArcMap automa-
ticky ponúka predvolenú geodatabázu s názvom Default. 

Pokročilí používatelia môžu využiť možnosť 4 . Do not show this dialog in the Future. 
Po ďalšom spustení ArcMapu sa toto okno už nezobrazí (obrázok 1).

Obrázok 1

Po výbere požadovaného mapového dokumentu sa spustí aplikácia ArcMap (5 . obrá-
zok 2). Umiestnenie jednotlivých líšt a veľkostí okien obsahu a mapového okna je 
možné prispôsobovať podľa potreby. Zobrazenie konkrétnej lišty alebo jej skrytie, 
resp. vypnutie, sa realizuje v hlavnom menu Customize → Toolbars. 
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Obrázok 2

2 .2 . Mapový dokument
Zoznam položiek v okne obsahu, symbológia prvkov, nastavenia kartografického zobra-

zovacieho systému, aktuálna mierka zobrazenia a mnoho ďalších parametrov sa ukladá do 
tzv. mapového dokumentu, t. j. súborového formátu s príponou .mxd. 

Otvorenie a uloženie mapových dokumentov sa realizuje prostredníctvom položky 1 . 
File v hlavnom menu, kde sú k dispozícii:

 •  Open – otvorenie mapového doku-
mentu,

 •  Save – bežné uloženie mapového 
dokumentu,

 • Save As – uloženie pod iným názvom 
než máme v súčasnosti,

 • Save A Copy – uloženie mapového 
dokumentu do staršej verzie aplikácie 
ArcMap. 

Mapový dokument vo forme súboru 2 . 
.mxd má svoje základné vlastnosti, ktoré 
je možné meniť vo File →  Map Docu-
ment Properties. Dialógové okno (Map 
Document Properties) ponúka náhľad 
adresárovej cesty mapového do ku mentu 
(.mxd), názov dokumentu, základné po-
pisné informácie k dokumentu, šta tistiky 
uloženia dokumentu, predvolenú geoda- Obrázok 3
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tabázu a možnosť jej zmeny i možnosť uloženia relatívnej adresárovej cesty k zdrojo-
vým vrstvám, tzn. bez viazania ku konkrétnemu disku alebo adresáru (obrázok 3).

Používateľ mapového dokumentu sa môže prihlásiť do cloud systému 3 . ArcGIS Online 
vo File →  Sign In. Používateľské prihlásenie umožní online prácu so systémom 
ArcGIS Online.
V prípade potreby exportu mapovej zostavy alebo obsahu mapového okna do 4 . obráz-
kových súborov využijeme položku File → Export Map.

2 .3 . Zobrazenie geografických informácií
Mapové okno je možné zobraziť v dvoch formách. Prvá forma s názvom Data View slúži 

na prácu v geografickom priestore. Druhá s názvom Layout View slúži na tvorbu mapovej 
zostavy, ktorá bude umiestnená na zvolenom formáte papiera, t. j. práca v grafickom priesto-
re. Obidve formy zobrazenia sú vzájomne previazané.

Geografické informácie, ktoré sú abstrahované v dátových modeloch, sa do aplikácie 
ArcMap pridávajú, resp. zobrazujú, prostredníctvom troch metód:

Najčastejšie sa geografické informácie pridávajú tlačidlom 1 .  Add Data, ktoré sa na-
chádza na lište štandardných nástrojov. Pridávanie vrstiev sa realizuje tromi spôsob-
mi:

Prvým spôsobom je pridanie vrstvy geografických informácií z lokálneho umiest- •
nenia, t. j. z nášho počítača alebo zo zariadení k nemu pripojených. Po stlačení 
tlačidla  Add Data sa zobrazí dialógové okno (obrázok 4), ktoré ponúka nie-
koľko možností na listovanie zdrojových súborov. Najprv si musíme vytvoriť tzv. 
pripojenie na konkrétny disk alebo adresár, kde sa naše údaje nachádzajú. Pripo-
jenie sa vykoná prostredníctvom ikonky  Connect To Folder.

Obrázok 4
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Ďalším spôsobom je pridanie geografických informácií v podobe mapových pod- •
kladov zo systému ArcGIS Online. Z ikonky  Add Data vysunieme padajúce 
menu, z ktorého vyberieme položku Add Basemap.

Posledný spôsob je pridanie geografických informácií z cloud systému  • ArcGIS 
Online, a to buď prihlásením na osobný účet alebo anonymným prístupom.

Ďalšou metódou je pridanie geografických informácií z aplikácie ArcCatalog, ktorá 2 . 
sa nachádza na bočnom paneli (obrázok 5). Aplikáciu ArcCatalog je možné spustiť 
aj ako samostatnú aplikáciu. V bočnom paneli aplikácie ArcMap máme k dispozícii 
jej zjednodušenú verziu.

Obrázok 5

Poslednou metódou zobrazenia geografických informácií je pridávanie vrstiev 3 . 
prostredníctvom GIS serverových služieb. Z tejto oblasti sa najčastejšie používajú 
služby WMS (Web Map Service). Ide o komunikačný protokol medzi klientom a ser-
verom, na základe ktorého dochádza k dátovému toku georeferencovaných obrázkov 
s mapovým obsahom. 

Pridanie WMS vrstvy sa realizuje v dialógovom okne  • Add Data. V padajúcom 
menu Look in nalistujeme položku GIS Servers. Následne sa zobrazí niekoľko 
položiek, z ktorých vyberieme Add WMS Server.

Do dialógového okna  • Add WMS Server vložíme url adresu WMS služby. Tlačid-
lom Get Layers získame zoznam dostupných vrstiev pod danou url adresou.

Po akceptovaní vloženej url adresy sa vrátime späť do dialógového okna  • Add 
WMS Server. V základnom zozname sa bude nachádzať nová položka, ktorú 
vyberieme tlačidlom Add, čím sa presunieme do organizačnej štruktúry danej 
WMS vrstvy. Každým dvojklikom na položku získame jej nižšiu organizačnú 
štruktúru (obrázok 6).
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Na nejednotný kartografický zobrazovací systém medzi WMS vrstvou a mapo- •
vým oknom nás program upozorní v dialógovom okne Geographic Coordinate 
System Warning. 

Obrázok 6

Zobrazené vrstvy môžeme prehliadať lištou Tools, ktorá obsahuje nasledovné nástroje:

 •  Zoom In – priblíženie obsahu mapového okna, čím sa mení aj mierka zobrazenia,

 •  Zoom Out – oddialenie obsahu mapového okna, čím sa mení aj mierka zobraze-
nia,

 •  Pan – posúvanie zobrazeného obsahu mapového okna,

 •  Full Extent – zobrazenie celého rozsahu mapového okna,

 •  Fixed Zoom In – priblíženie s dôrazom na stred mapového okna,

 •  Fixed Zoom Out – oddialenie s dôrazom na stred mapového okna,

 •  Go Back To Previous Extent – zobrazenie mapového okna o krok späť,

 •  Go Front To Next Extent – zobrazenie mapového okna o krok dopredu,

 •  Select Features – interaktívny výber prvkov; padajúce menu poskytuje možnosť 
výberu z rôznych geometrických útvarov (polygón, línia, obdĺžnik, kruh atď.),

 •  Clear Selected Features – hromadné zrušenie výberu prvkov,

 •  Select Elements – výber grafických objektov v mapovom okne,

 •  Identify – identifikácia atribútových vlastností prvkov geografickej vrstvy,

 •  Hyperlink a HTML Popup – nástroje webového rozhrania,
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 •  Measure – meranie vzdialeností,

 •  Find – vyhľadávanie objektov v mapovom dokumente,
 •  Find Route – vyhľadávanie ciest prvkami,
 •  Go To XY – vyhľadávanie miesta na základe X a Y súradníc,
 •  Time Slider – vizualizácia časového aspektu geografických informácií,
 •  Create Viewer Window – okno s priblíženým obsahom zvolenej oblasti.

Zobrazené geografické informácie je možné meniť dvomi spôsobmi. Prvým spôsobom 
je možnosť použitia nástrojov lišty Tools. Druhým spôsobom je zmena číselnej hodnoty 
v padajúcom menu mierky (obrázok 7), ktoré je umiestnené na lište štandardných nástrojov 
(Standard). Padajúce menu mierky je aktívne len v tom prípade, ak sú pre dátový rám nasta-
vené pracovné jednotky alebo kartografický zobrazovací systém. Mierku je možné vložiť aj 
mimo zadefinovaných hodnôt, a to manuálnym zadaním nami požadovaného čísla. Prípad-
ne sa rozsah a forma zobrazenia hodnôt upraví v položke <Customize This List…>. 

Obrázok 7

2 .4 . Okno obsahu – Table of Contens
Okno obsahu je určitým správcom zoradenia vrstiev a zmeny štýlov ich zobrazenia (ob-

rázok 8). Okno obsahu ponúka niekoľko spôsobov organizácie vrstiev do zoznamu, a to 
podľa:

 •  List By Drawing Order – nami priradeného poradia,

 •  List By Source – zdroja, resp. adresárových ciest zobrazených vrstiev,



14

 •  List By Visibility – viditeľnosti zobrazených vrstiev v mapovom okne, ktoré bude 
štruktúrované na dve kategórie, t. j. na vrstvy zapnuté a vypnuté pre svoje zobraze-
nie,

 •  List By Selection – výberu prvkov vo vrstvách. 

Obrázok 8

Záhlavie okna ponúka položku  Options, ktorou sa realizujú nastavenia organizácie 
vrstiev v okne obsahu. V nastaveniach sa prispôsobuje veľkosť, tvar symbolov vo vrstvách, 
spôsob zoradenia položiek a možnosť voľby zobrazenia vybraných prvkov v časti  List by 
Selection. Okno obsahu je možné skryť a následne zobraziť prostredníctvom Windows → 

 Table of Contens.

Okno obsahu je štruktúrované do dátových rámov (  Data Frame), vrstiev (Layers) 
a ich skupín (  Group Layer). V jednom okne obsahu môže byť umiestnených niekoľko 
dátových rámov, skupín vrstiev a samostatných vrstiev. Úpravu zoznamu vrstiev a formu ich 
zobrazenia vykonávame prostredníctvom spektra rôznych operácií:

Najjednoduchšou operáciou v okne obsahu je zmena poradia vrstiev. Voľbou správ-1 . 
neho poradia dokážeme eliminovať vzájomné obsahové prekrývanie. Podobný prin-
cíp sa uplatňuje v kartografii alebo v grafických informačných systémoch. 
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Ďalšou operáciou je zapínanie a vy-2 . 
pínanie zobrazenia vrstiev pros-
tredníctvom zaškrtávacieho políčka 
k danej vrstve. 

Zmena názvu sa vykoná dlhším klik-3 . 
nutím na položku vrstvy alebo stlače-
ním klávesy „F2“.

Ku každej vrstve je možné spustiť 4 . 
(kliknutie pravým tlačidlom myši) tzv. 
kontextové menu s nasledovným vý-
berom položiek (obrázok 9):

 •  Remove – odstránenie vrstvy 
z okna obsahu,

 •  Open Attribute Table – spus-
tenie atribútovej tabuľky k danej 
vrstve,

 • Joins and Relates – definovanie 
prepojení a vzťahov medzi vrstva-
mi,

 •  Zoom To Layer – pohľad na celý 
rozsah vrstvy,

Selection •  – nástroje výberu prvkov 
v danej vrstve,

 • Edit Features – nástroje tvorby 
a editácie prvkov v danej vrstve,

Data •  – nástroje exportu obsahu 
vrstvy,

 •  Save As Layer File – uloženie 
vrstvy do tzv. layer formátu,

 •  Properties – úprava vlastností 
danej vrstvy.

Ku každému dátovému rámu je možné 5 . 
spustiť kontextové menu s nasledov-
ným výberom položiek (obrázok 10): 

 •  Add Data – pridanie vrstvy do okna 
obsahu a jej následné zobrazenie v mapovom okne,

 •  New Group Layer – vytvorenie novej skupiny vrstiev,

 •  Copy – kopírovanie dátového rámu a jeho obsahu,

 •  Paste Layer(s) – vloženie skopírovaných vrstiev do dátového rámu,

 •  Remove – odstránenie dátového rámu z okna obsahu,

Obrázok 9

Obrázok 10
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 • Turn All Layers On – zapnutie zobrazenia všetkých vrstiev v dátovom ráme,
 • Turn All Layers Off – vypnutie zobrazenia všetkých vrstiev v dátovom ráme,
 • Select All Layers – výber všetkých vrstiev, ktoré sú organizačne umiestnené pod 

dátovým rámom,
 • Expand All Layers – rozbalenie podrobnej organizačnej štruktúry dátového 

rámu,

 • Collapse All Layers – zbalenie podrobnej organizačnej štruktúry dátového 
rámu,

 • Active – aktivácia dátového rámu. V prípade viacerých dátových rámov je možné 
pracovať len s aktívnym. Potreba viacerých dátových rámov vyplýva z mapových 
kompozícií, t. j. na jednom mapovom liste sa môže nachádzať niekoľko mapo-
vých polí.

Hlavnou položkou kontextového menu dátového rámu (6 . Data Frame) je  Proper-
ties. Touto položkou upravujeme základné nastavenie (vlastnosti) dátového rámu, 
a to v nasledovnom rozsahu:

General6 .1 .  – všeobecné nastave-
nie ako názov dátového rámu, 
popis, pracovné jednotky (dá-
tové a mapové zobrazenie) a re-
ferenčná mierka. Referenčná 
mierka je číslo, pri ktorom sa 
veľkosť mapových znakov bude 
zobrazovať podľa našej zadanej 
špecifikácie (obrázok 11). Napr. 
línia o hrúbke 2 bodov sa bude 
zobrazovať len pri referenčnej 
mierke 1 : 50 000. Mimo tejto 
hodnoty sa bude hrúbka línie 
meniť. Bez nastavenia referenč-
nej mierky bude štýl mapové-
ho znaku zobrazovaný kon-
štantne, a to v každej mierke, 
napr. v mierke 1 : 10 000, ale aj 
v mierke 1 : 500 000 bude hrúb-
ka línie napr. 2 body.

6 .2 . Data Frame – nastavenie rozsahu zobrazovania geografických informácií v ma-
povom okne. K dispozícii máme tri možnosti:

Automatic •  – plný rozsah zobrazených vrstiev dátového rámu v mapovom 
okne.

Fixed Scale •  – zobrazenie vrstiev dátového rámu len v zadanej mierke, nie je 
možné priblížiť ani oddialiť obsah mapového okna. Jedinou možnosťou je len 
operácia posunu zobrazeného obsahu.

Obrázok 11
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Fixed Extent  • – fixovaný pohľad na aktuálne zobrazený rozsah mapového 
okna. Rozsah zobrazenia nie je možné priblížiť, oddialiť, ani posúvať.

6 .3 . Coordinate System – nastavenie kartografického zobrazovacieho systému všetkých 
vrstiev v dátovom ráme. Každá vrstva by mala mať zadefinovaný vlastný kartografic-
ký zobrazovací systém. Pre dátový rám môže byť nastavený len jeden kartografický 
zobrazovací systém. K dispozícii máme niekoľko položiek na výber nami požadova-
ného systému. Pre územie Slovenska sa najčastejšie používa kartografický zobrazo-
vací systém Křovák/S-JTSK, ktorý je zaradený do Projected Coordinate Systems → 
National Grids → Europe → S-JTSK Krovak EastNorth. Toto nastavenie odporúča-
me vykonať vždy na začiatku práce s aplikáciou ArcMap. 

Pokiaľ sa rozhodneme meniť kartografický zobrazovací systém počas našej práce, dôjde 
k prevodu zobrazenia všetkých vrstiev, ktoré sa nachádzajú v okne obsahu.

Vrstva, ktorú pridávame do okna obsahu a ktorá má vlastný zobrazovací systém, bude 
transformovaná do kartografického zobrazovacieho systému dátového rámu. 

2 .5 . Vrstva geografických informácií
Aplikácia ArcMap ponúka široké spektrum parametrov zobrazenia vrstiev geografic-

kých informácií. Ide hlavne o priradenie štýlov na zobrazenie prvkov vrstvy, popisov k prv-
kom, atribútov atď. Samotné nastavenia štýlov prvkov vrstvy úzko súvisia s výpovednou 
hodnotou GIS produktov. 

Nastavenie parametrov zobrazenia a práce s vrstvou sa realizuje v dialógovom okne s ná-
zvom Layer Properties, ktoré spustíme kontextovým menu (  Properties) alebo dvojkli-
kom na danú vrstvu. V dialógovom okne máme k dispozícii niekoľko záložiek:

General1 .  – všeobecné nastavenie vrstvy, ako je jej názov, popis a rozsah mierky zo-
brazenia prvkov.

Source 2 . – záložka s popisom základných súborových a zobrazovacích parametrov. 
Tlačidlom Set Data Source môžeme meniť zdrojový súbor k danej vrstve, prípadne 
opraviť súborovú cestu pri zmene umiestnenia danej vrstvy v počítači. 

Selection3 .  – špecifikácia farebného nastavenia vybraných prvkov. 

Display4 .  – nastavenie priehľadnosti zobrazovaných prvkov, nastavenie hyperlinko-
vých odkazov atď.

5 . Symbology – zmena symbologického štýlu zobrazených prvkov (obrázok 12). V po-
nuke máme niekoľko možností zobrazenia prvkov obsiahnutých vo vrstve:

Features •  – jednoznaková symbologická interpretácia, t. j. každý prvok má rovna-
ké symbologické vyjadrenie.

Categories •  – viacúrovňové symbologické vyjadrenie, t. j. na základe hodnôt 
v atribútovej tabuľke sa prvky medzi sebou graficky odlišujú. Možnosť sa využíva 
na tvorbu tematických máp.

Quantities  • – pomerové grafické vyjadrenie, t. j. stanoveným rozsahom hodnôt 
z atribútovej tabuľky sa prvky medzi sebou vzájomne symbologicky odlišujú. Štýl 
sa využíva pri tvorbe tematických máp.
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Obrázok 12

Charts •  – číselné atribútové hodnoty prvkov, ktoré sú vyjadrené prostredníctvom 
grafu. Štýl sa využíva pri tvorbe kartodiagramov. 

Multiple  • Attributes – grafické vyjadrenie viacerými spôsobmi súčasne, t. j. na 
jednom mieste môže byť tematické, pomerové a symbologické vyjadrenie.

6 . Fields – zmena poradia atribútov, priradenie alebo zmena tzv. aliasu atribútov a fa-
rebné zvýraznenie v atribútovej tabuľke.

Definition Query7 .  – pomocou výrazov jazyka SQL a hodnôt atribútovej tabuľky je 
možné zobraziť len určitú časť vrstvy.

8 . Labels – tvorba textových anotácií k jednotlivým prvkom. Textové anotácie sa pri-
dávajú k prvkom podľa atribútovej tabuľky. 

Joins 9 . & Relates – prepojenia a vzťahy medzi minimálne dvoma atribútovými tabuľ-
kami alebo atribútovou tabuľkou a externou databázou.

Time 10 . a HTML Popup – prvá záložka je zameraná na nastavenie časového aspektu 
a druhá záložka je určená na nastavenie webového rozhrania. 
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2 .6 . Atribútová tabuľka
Atribútová tabuľka predstavuje databázové rozhranie, t. j. databázu údajov k prvkom da-

nej vrstvy. Údaje sú v tabuľke organizované do stĺpcov a riadkov, pričom každý stĺpec (Field) 
predstavuje atribút a riadky predstavujú záznamy. 

Atribútovú tabuľku k danej vrstve je možné otvoriť v jej kontextovom menu a polož-1 . 
ke  Open Attribute Table.

Atribútová tabuľka obsahuje základné obslužné ikonky a databázové pole, t. j. riadky 2 . 
ako záznamy a stĺpce ako atribút. Úpravu jednotlivých záznamov je možné vykonať 
len v tzv. editovateľnom móde. Základné obslužné ikonky majú nasledovné funkcie: 

 •  Related Tables – zoznam atribútových tabuliek, s ktorými je vytvorené prepo-
jenie, resp. určitý vzťah;

 •  Select By Attributes – výber záznamov formou výrazov jazyka SQL;

 •  Switch Selection – inverzná zmena výberu záznamov;

 •  Clear Selection – zrušenie aktuálneho výberu;

 •  Zoom To Selected – zobrazenie vybraných záznamov, resp. prvkov v mapo-
vom okne;

 •  Table Options – padajúce menu, v ktorom sa nachádzajú rozšírené možnosti 
vyššie opísaných funkcií. Zároveň sa tu nachádzajú aj ďalšie dôležité nástroje, 
akými sú napr.: 

Add Field – •  pridanie nového stĺpca do atribútovej tabuľky,

Restore Default Column Widths – •  v prípade zmeny šírky stĺpca nástroj ob-
noví pôvodnú šírku,

Restore Default Field  • Order – v prípade zmeny poradia stĺpcov nástroj ob-
noví ich pôvodné poradie,

Add Table to  • Layout – pridanie atribútovej tabuľky do mapovej zostavy,

Export  • – uloženie atribútovej tabuľky do externého súborového formátu,

Appearance  • – nastavenie vzhľadu zobrazovania atribútovej tabuľky, t. j. farba 
výberu, font, veľkosť textu atď.

Ďalšie nástroje na prácu s atribútovou tabuľkou ponúka kontextové menu v záhlaví 3 . 
každého stĺpca (obrázok 13):

 •  Sort Ascending – zoradenie záznamov vzostupným smerom,

 • Sort Descending – zoradenie záznamov klesajúcim smerom,

Advanced Sorting •  – zoradenie záznamov podľa viacerých kritérií,

 • Summarize – tvorba súhrnných štatistík, ako napr. počet prvkov k danému 
záznamu, minimálne a maximálne číselné hodnoty v danom atribúte atď.,

 •  Statistics – štatistika viazaná len k číselným záznamom v rozsahu: počet zázna-
mov, minimálna a maximálna hodnota, súčet, priemer, štandardná odchýlka 
a počet záznamov s nulovou hodnotou (obrázok 14),
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Obrázok 13

Obrázok 14

 • Field Calculator – atribútová kalkulačka, napr. súčet dvoch číselných stĺpcov (ob-
rázok 15),

 •  Calculate Geometry – výpočet plošných a dĺžkových hodnôt k jednotlivým 
záznamom,

Turn Field Off  • – daný stĺpec sa nebude zobrazovať, opätovne ho môžeme zobraziť 
vo vlastnostiach danej vrstvy (Layer Properties) v záložke Field,

 • Freeze/Unfreeze – zmrazenie stĺpca, t. j. jeho stále zobrazenie pri horizontálnom 
listovaní v atribútovej tabuľke,
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 •  Delete Field – odstránenie stĺpca,

 •  Properties – zapnutie/vypnutie zobrazenia stĺpca, priradenie parametra len na 
čítanie a farebné zvýraznenie stĺpca.

Obrázok 15

Otázky:

Aký súborový formát sa používa pre mapový dokument aplikácie ArcMap?1. 

Akým spôsobom sa najčastejšie pridávajú geografické informácie do 2. 
mapového okna v aplikácii ArcMap?

Čo je WMS služba?3. 

Ktoré operácie, resp. nástroje, ponúka lišta s názvom 4. Tools?

Akú funkciu má okno obsahu – 5. Table of Contens?

Čo je atribútová tabuľka a aké funkcie vykonáva?6. 
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3 . Práca s ArcCatalog
ArcCatalog je aplikácia určená na správu geografických informácií, ide o tzv. manažé-

ra priestorových informácií. ArcCatalog spravuje geografické informácie v adresárovom 
priestore alebo v geodatabázach. Adresárovým priestorom je konkrétny disk alebo adre-
sár, v ktorom sú geografické informácie uložené. Geodatabáza je podrobne štruktúrované 
prostredie na ukladanie geografických informácií. V ArcGISe môžu mať geodatabázy nasle-
dovné formy:

1 . Súborová geodatabáza ( .gdb) – databázový priestor na uloženie väčšieho rozsahu 
geografických informácií so širokou podporou rôznych typov operačných systémov.

Personálna geodatabáza ( .mdb)2 .  – na platforme Microsoft Access s limitovanou 
podporou operačného systému a obmedzenou veľkosťou ukladania geografických 
informácií.

3 . ArcSDE geodatabáza – bez obmedzení veľkosti a operačného systému, určená pre 
platformy Oracle, SQL Server, Informix, DB2 alebo PostgreSQL. 

3 .1 . Spustenie aplikácie ArcCatalog
Aplikácia ArcCatalog je kompozične štruktúrovaná do niekoľkých častí, ktoré je možné 

prispôsobiť podľa vlastných potrieb (obrázok 16).

Okno stromovej štruktúry ponúka prístup ku geografickým informáciám a GIS ná-1 . 
strojom, ktoré sa nachádzajú na diskoch, v adresároch alebo na serveroch. Prostred-

Obrázok 16
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níctvom okna stromovej štruktúry je možné geografické informácie a nástroje spra-
vovať, tzn. vyhľadávať, organizovať, kopírovať, odstraňovať, popisovať atď.

Okno obsahu a náhľadu ponúka 3 varianty zobrazenia vybraných položiek stromovej 2 . 
štruktúry (obrázok 17):

Obrázok 17

Contents •  – zobrazenie obsahu nalistovaného adresára. Formu zobrazenia si volí-
me prostredníctvom ikoniek  Large Icons,  List,  Details a  Thumbnails, 
ktoré sa nachádzajú v štandardnom menu.

Preview •  – geografické 2D, geografické 3D a databázové zobrazenie vybraného 
zdroja resp. súboru geografických informácií. Geografické zobrazenie obsahu-
je základné nástroje lišty Tools z aplikácie ArcMap, čiže zmenu mierky, polohy 
zobrazenia a identifikáciu prvkov. V prípade dostupného rozšírenia 3D Ana-
lyst je možné zobrazovať 3D dimenziu geografických informácií (Globe View, 
3D View). Databázové rozhranie ponúka zobrazenie atribútovej tabuľky. Obslu-
ha atribútovej tabuľky sa vykonáva pomocou základného súboru nástrojov, t. j. 
listovanie v záznamoch atribútovej tabuľky, vyhľadávanie, triedenie, pridávanie 
nových stĺpcov atď. Nástroje sú umiestnené buď pod padajúcim menu  Table 
Options alebo v kontextovom menu k jednotlivým stĺpcom. 

Description •  – popis vybranej položky v zmysle rozšíriteľného značkovacieho ja-
zyka XML (Extensible Markup Language). Ide o programovací jazyk, ktorým sa 
vytvára štruktúrovaný popis za účelom efektívnejšej výmeny informácií. V tejto 
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časti okna môžeme k súborom vytvárať, upravovať, importovať externé informá-
cie a zároveň ich tlačiť.

Štandardná lišta (3 . Standard) obsahuje nástroje, ktoré sú určené na základnú prácu 
s oknom stromovej štruktúry:

 •  Up One Level – v aktuálne zvolenom mieste sa dostaneme o organizačnú úro-
veň vyššie.

 •  Connect To Folder – pripojenie adresára k tzv. koreňovej adresárovej štruktú-
re. Postupným výberom môžeme vytvoriť niekoľko pripojení. Hlavným účelom 
je uľahčiť prístup k zložitým adresárovým štruktúram.

 •  Disconnect Folder – odpojenie adresára z tzv. koreňovej adresárovej štruktú-
ry.

 •  Copy,  Paste a  Delete – správa adresárov i súborov v rozsahu kopírovania, 
vkladania a mazania.

V štandardnej lište sa nachádzajú 4 formy zobrazenia časti Preview. K dispozícii máme 
ešte časť menu, z ktorého je možné spustiť jednotlivé aplikácie systému ArcGIS.

Hlavné menu ponúka širokú paletu nástrojov, avšak mnohé z nich sú umiestnené 4 . 
v samostatných oknách alebo lištách.

File 4 .1 . – obsahuje položky na tvorbu nových súborových formátov geografických 
informácií a nástrojov (New), základné nástroje štandardnej lišty (  Connect 
To Folder /  Disconnect Folder,  Delete, Rename), možnosť prihlásenia sa 
do systému ArcGIS Online (  Sign In) a položku systémových vlastností (  
Properties) daného súboru a adresára.

Edit 4 .2 . – nástroje na kopírovanie a vkladanie súborových formátov.

View 4 .3 . – nástroje na aktualizáciu ob-
razu (  Refresh) a zobrazenie/skry-
tie stavového riadku (Status Bar).

Go4 .4 .  – nástroj navigácie (  Up One 
Level) v organizačnej štruktúre 
okna obsahu.

Geoprocessing4 .5 .  – súbor nástrojov 
geo procesingu.

Customize4 .6 .  – obsahuje položky na 
zobrazenie/skrytie panelov nás tro-
jov (Toolbars) ArcCatalogu, na sprá-
vu rozšírení (Extensions a Add-In 
Manager), položky určené na pri-
spôsobenie hlavného menu (Custo-
mize Mode) a všeobecné nastavenie 
ArcCatalogu (ArcCatalog Options), 
ktoré má nasledovné možnosti (ob-
rázok 18): Obrázok 18
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General  • – voľba rozsahu a formy zobrazovaných položiek v okne stromovej 
štruktúry, napr. možnosť zobrazovania položky GIS Servers, Toolboxes, zo-
brazenie súborových prípon atď.;

File Types •  – voľba súborových formátov, ktoré budú zobrazované k štan-
dardným ArcGIS súborovým formátom;

Contens  • – nastavenia detailného (  Details) zobrazenia variantu Contens 
okna obsahu. V druhej časti záložky je ponuka možností zobrazenia autor-
ských atribútov k metaúdajom;

Connections  • – v prípade potrebnej autorizácie pripojenia prostredníctvom 
proxy servera je táto časť určená na zadanie používateľského mena a hesla;

Metadata •  – štýl zobrazenia metaúdajov;

Tables •  – štýl zobrazenia atribútovej tabuľky;

Raster •  – nastavenie parametrov zobrazenia obrázkových, čiže rastrových 
súborových formátov;

CAD •  – rozsah zobrazenia .dgn súborového formátu.

Windows 4 .7 . – obsahuje možnosť zobrazenia/skrytia okna stromovej štruktúry (  
Catalog Tree) a okna vyhľadávania (  Search).

Help 4 .8 . – položky tzv. ArcGIS pomocníka.

3 .2 . Súborové formáty geografických informácií
Aplikácia ArcCatalog ponúka niekoľko možností správy pracovného priestoru a sú-

borových formátov. Správou rozumieme kopírovanie, odstraňovanie, zmeny názvov sú-
borov, adresárov a geodatabáz, ďalej 
zmeny v štruktúre atribútových tabu-
liek, modifikácie alebo priradenie kar-
tografických zobrazovacích sys témov. 
Do správy zaraďujeme aj vytváranie 
nových súborov geo gra fic kých infor-
mácií a pracovných priestorov.

Vytváranie súborov geografických 
informácií sa realizuje v kontextovom 
menu a jeho položke New alebo polož-
kou hlavného menu File → New. Na 
mieste, kde chceme mať umiestnený 
novovytvorený súbor, adresár alebo 
geo databázu, zvolíme položku New, 
a to v kontextovom menu alebo v hlav-
nom menu. Položka New ponúka na-
sledovné možnosti (obrázok 19):

 •  Folder – vytvorenie nového 
adresára,

Obrázok 19
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 •  File Geodatabase – vytvorenie súborovej geodatabázy,

 •  Personal Geodatabase – vytvorenie personálnej geodatabázy na báze Microsoft 
Access,

 •  Database Connections a  ArcGIS Server Connection – pripojenie k databázam 
a serverom, ktoré obsahujú štruktúrované umiestnenie geografických informácií,

 •  Layer a  Layer Group – vytvorenie súborov .lyr a ich zlúčenie do skupín za úče-
lom pohodlnejšej organizácie položiek v okne obsahu aplikácie ArcMap,

 •  Python Toolbox – vytvorenie položky nástroja na báze programovacieho jazyka 
Python,

 •  Shapefile – vytvorenie súborových formátov .shp, ktoré sú určené na ukladanie 
vrstiev geografických informácií s ich geometrickým, priestorovým a databázovým 
rozhraním vo forme bodov, línií a polygónov,

 •  Turn Feature Class – sieťové operácie medzi prvkami geografických informácií,

 •  Toolbox – vytvorenie .tbx súboru, v ktorom sú organizované nástroje aplikácie 
ArcToolBox,

 •  dBase Table – vytvorenie atribútovej tabuľky formátu dBase,

 •  LAS – vytvorenie dátového formátu na uloženie výstupov z diaľkového prieskumu 
Zeme na báze LIDAR (light detection and ranging),

 •  Address Locator a  Composite Address Locator – nástroje na tvorbu geokódo-
vacích súborových formátov,

 •  XML Document – vytvorenie metaúdajového súboru .xml. 
V prípade vytvárania súborovej geodatabázy (  File Geodatabase) alebo personálnej 

geodatabázy (  Personal Geodatabase) ide o typy geodatabáz, ktoré majú rovnakú organi-
začnú štruktúru. Avšak obidve geodatabázy poskytujú rôzne kľúčové vlastnosti (typ operač-
ného systému, kapacitu na uloženie dát, bezpečnosť atď.) práce s geografickými informácia-
mi. Kontextové menu obidvoch geodatabáz ponúka nasledovný rozsah položiek:

1 .  Copy – kopírovanie geodatabázy,

2 .  Paste – vloženie geodatabázy,

3 .  Delete – odstránenie geodatabázy,

Rename4 .  – zmena názvu geodatabázy,

5 .  Refresh – aktualizácia obsahu geodatabázy,

Administration 6 . – nástroje administrácie danej súborovej geodatabázy:

 •  Compact Database – defragmentácia geodatabázy na pevnom disku, čím môže 
dôjsť k zrýchleniu prístupu k dátam a zmenšeniu jej veľkosti;

Compress  • – kompresia geodatabázy, čím dôjde k jej zmenšeniu, ale zároveň sa 
prepne do módu len na čítanie, tzv. read-only;

Uncompress  • File Geodatabase – dekompresia veľkosti geodatabázy, t. j. veľkosť 
geodatabázy bude mať pôvodnú veľkosť, zároveň sa odstráni mód len na čítanie;
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Distributed Geodatabase7 .  – ná-
stroje na distribúciu geodatabázy, 
tzn. replikáciu jej obsahu, vykona-
ných zmien, popisov atď.,

New 8 . – nástroje na organizačné 
štruktúrovanie geodatabázy (obrá-
zok 20): 

8 .1 .  Feature Dataset – súbor prv-
kov vektorových geografic-
kých informácií s rovnakým 
alebo podobným tematickým 
obsahom, ktoré sú previazané 
jedným kartografickým zobra-
zovacím sys témom, špecifiko-
vanou to pológiou, relačným 
databázovým vzťahom atď. V jednom  Feature Dataset môže byť niekoľko sa-
mostatných vrstiev geografických informácií (  Feature Class). Vrstvy prvkov 
môžu mať rozdielne geometrické (obrázok 21) a databázové rozhranie (obrázok 
22). Súbor prvkov  Feature Dataset je určitou organizačnou jednotkou (ad-
resár), do ktorej sa ukladajú prvky s presne definovanou špecifikáciou kartogra-
fického zobrazovacieho systému, topológiou, databázou atď. So súborom prvkov 
je možné vykonať rôzne operácie (obrázok 23) prostredníctvom kontextového 
menu  Feature Dataset, napr. export (Export), import (Import) údajov alebo 
správu údajov (Manage).

8 .2 .  Feature Class – vektorová vrstva prvkov geografických informácií bez zara-
denia do konkrétneho súboru prvkov (  Feature Dataset). Každej vrstve prv-
kov je potrebné samostatne definovať kartografický zobrazovací systém, zatiaľ 
čo vo  Feature Dataset 
sa definoval len jeden kar-
tografický zobrazovací sys-
tém a následne sa uplatňoval 
vo všetkých jeho položkách. 
Taktiež pri samostatnej vrstve 
prvkov nemáme k dispozícii 
mož nosti špecifikácie topo-
logických pravidiel.

8 .3 .  Table – atribútová ta buľ-
ka, resp. databáza úda jov 
bez geografického a geo-
metrického rozhrania. Pri 
vytváraní atribútovej tabuľky 
je potrebné definovať para-
metre databázového ulo že-
nia a štruktúru atribútov.

Obrázok 20

Obrázok 21
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8 .4 .  Raster Catalog,  Raster Dataset a  Mosaic Dataset – položky organizačné-
ho štruktúrovania geografických informácií v rastrových dátových formátoch.

8 .5 .  Toolbox – priestor na umiestnenie vybraného nástroja z aplikácie Toolbox, 
algoritmov programovacieho jazyka XSL a algoritmov aplikácie Model Builder.

8 .6 .  Address Locator a  Composite Address Locator – položky umiestnenia geo-
kódovacích súborových formátov.

Import9 .  – import geografických informácií z iných súborových formátov alebo geo-
databáz. V ponuke máme k dispozícii individuálny alebo hromadný import. Polož-
ka s rovnakou funkciou a rovnakým názvom sa nachádza aj v kontextovom menu 
súboru prvkov (  Feature Dataset). Pri vrstve prvkov (  Feature Class) sa bude 
zobrazovať položka pod názvom Load, avšak s rovnakou funkciou ako Import.

Export 10 . – export geografických 
informácií do iných súboro-
vých formátov, geodatabáz, 
CAD alebo databázových sys-
témov. Opäť je v ponuke indivi-
duálny alebo hromadný export. 
S rov nakou funkciou a názvom 
položky sa môžeme stretnúť 
v každej organizačnej štruktúre 
geodatabázy s obsahom geo-
grafických informácií.

11 .  Share as Geodata Service – 
publikovanie geografických in-
formácií prostredníctvom slu-
žieb, ktoré poskytuje produkt 
ArcGIS Server.

Obrázok 22

Obrázok 23
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12 .  Properties – vlastnosti databázy. 
S touto položkou sa môžeme stretnúť 
na každej organizačnej úrovni geoda-
tabázy. Avšak na každej úrovni posky-
tuje iný rozsah možností úprav, resp. 
nastavenia danej položky.

V prípade výberu položky  Shapefile 
vytvoríme prázdnu vrstvu geografických in-
formácií. 

Zobrazí sa dialógové okno s názvom 1 . 
Create New Shapefile, v ktorom je 
potrebné zadať názov .shp súboru, typ 
geometrie a kartografický zobrazova-
cí systém (obrázok 24). 

Vytvorenému súboru je potreb-2 . 
né up raviť databázovú štruktúru 
v kon textovom menu a položke  
Properties.

V dialógovom okne s názvom 3 . Shape-
file Properties máme k dis pozícii nie-
koľko záložiek:

General •  – všeobecné informácie 
o .shp súbore, t. j. jeho názov, typ 
a vlastnosti geometrie;

XY  • Coordinate System – zmena 
alebo nastavenie kartografického 
zobrazovacieho systému .shp sú-
boru;

Domain, Resolution and To- •
lerance – parametre karto gra-
fického zobrazovacieho systému, 
t. j. priestorový rozsah na súradni-
cových osiach, rozlíšenie na súradnicových osiach a tolerancia minimálnej vzdia-
lenosti medzi súradnicami;

 • Fields – štruktúrovanie atribútovej tabuľky (obrázok 25), v časti s názvom Field 
Name zadávame názov atribútu a v časti Data Type údajový typ, teda či to bude 
textový záznam, číselný, dátumový atď. Jednotlivé položky (riadky) je možné od-
strániť klávesou Delete;

Indexes  • – databázové a priestorové indexácie za účelom zrýchlenia práce so sú-
borom .shp;

Feature Extent •  – priestorové obmedzenie prvkov geografických informácií.

Obrázok 24

Obrázok 25
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Obrázok 26

Správne organizačne štruktúrovaná geodatabáza alebo pracovný priestor je dôležitým 
faktorom rýchlej a efektívnej práce s veľkým množstvom geografických informácií (obrázok 
26). Každý typ poskytuje svoje výhody a nevýhody. Na abstrahovanie menšieho množstva 
údajov bez dôrazu na relačné databázové vzťahy a topologické pravidlá je postačujúci súbo-
rový formát .shp. Avšak pre väčšie množstvo údajov, resp. väčšiu výmeru abstrahovaného 
územia so zložitou štruktúrou prvkov, je ideálna súborová geodatabáza. 

3 .3 . Pripojenie ArcCatalógu k externým informačným zdrojom
Kľúčovým aspektom používania aplikácie ArcCatalog je nadviazanie spojenia so zdro-

jom geografických informácií, ktorý budeme pri práci používať. ArcCatalog ponúka nasle-
dovné možnosti pripojenia:

adresárové pripojenie použitím ikonky 1 .  Connect To Folder tak, ako to bolo opísa-
né v predchádzajúcich častiach,

pripojenie k SQL serveru za účelom správy geodatabázy – SQL Server Express 2 . 
prostredníctvom  Database Servers →  Add Database Server,

pripojenie ku ArcSDE geodatabázam s platformou SQL Server Express, SQL Server, 3 . 
Oracle, DB2, Informix a PostgreSQL prostredníctvom  Database Connections → 

 Add Database Connection,

pripojenie k serverom na báze 4 . ArcGIS Server, ArcIMS server, WMS a WCS v po-
ložke okna stromovej štruktúry  GIS Servers. Ide o služby, ktoré sú publikované 
a prístupné v technológiách a protokoloch internetového rozhrania. 

Otázky:

Aký účel má aplikácia ArcCatalog?1. 

Aké typy geodatabáz môžeme používať v ArcGISe?2. 

Aký je rozdiel medzi personálnou a súborovou geodatabázou?3. 

Pomocou akých položiek vytvoríme .shp vrstvu geografických informácií?4. 

K akým externým informačným zdrojom sa najčastejšie pripájame 5. 
aplikáciou ArcCatalog?
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4 . Tvorba a úprava geografických informácií 
Východiskovým bodom akejkoľvek operácie tvorby a úpravy geografických informácií 

je lišta s názvom Editor. Táto lišta predstavuje súbor nástrojov tvorby, úpravy, kopírovania 
existujúcej geometrie, delenia, spájania, zarovnávania, prichytávania prvkov geografických 
informácií. Lišta sa rozvetvuje na niekoľko ďalších líšt, samostatných menu, vyskakujúcich 
okien alebo na bočné panely. 

4 .1 . Lišta Editor – nástroje
Lištu 1 . Editor môžeme zobraziť ikonkou  Editor Toolbar alebo použitím hlavného 
menu Customize → Toolbars → Editor.

Zobrazená lišta je v tzv. neaktívnom móde. V okne obsahu sa nenachádzajú vrstvy, 2 . 
ktoré by sme mohli upravovať alebo im pridávať nové prvky.

Po pridaní vrstiev do okna obsahu je možné pristúpiť k tvorbe alebo úprave (ďalej len 3 . 
„editovanie“) prvkov. V padajúcom menu lišty Editor máme k dispozícii položku  
Start Editing, ktorou sa spustí proces editovania. Druhou možnosťou začatia edito-
vania je kontextové menu k danej vrstve (obrázok 27), kde môžeme vybrať položku 
Edit Features → Editor.

Obrázok 27

V okne obsahu sa môžu nachádzať aj vrstvy, ktoré nie sú umiestnené v jednom adre-4 . 
sári. V tomto prípade sa zobrazí dialógové okno s názvom Start Editing. Vyberieme 
zdrojový adresár alebo geodatabázu s obsahom vrstiev, ktoré chceme editovať (ob-
rázok 28).
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Obrázok 28

Spustením procesu editovania sa sprístupní nasledovný súbor nástrojov:5 . 

 •  Edit Tool – výber a editovanie daného prvku. Kliknutím na prvok vykonáme 
jeho výber, dvojklikom zobrazíme k prvku jeho uzly, ktoré môžeme editovať – 
upravovať. Výber viacerých prvkov sa realizuje v okne výberu, resp. ohradou, ale-
bo pri výbere viacerých prvkov podržíme klávesu „Shift“. Obrázok 29 interpre-
tuje rozsah výberu príslušného prvku. Prvok 1 nie je vybraný, prvok 2 je vybraný, 
prvok 3 je zobrazený aj s jeho uzlami a okno výberu je označené číslom 4.

 •  Edit Annotation Tool – editovanie anotácií, resp. popisov, ktoré sú reprezen-
to va né ako samostatná GIS vrstva. Nástroj je aktívny len pre vektorovú vrstvu 
prv kov v kategórii  Feature Class 
(so za radením do  Feature Data-
set alebo bez zaradenia) súborovej 
geo databázy (  File Geodataba-
se) alebo personálnej geodatabázy  
(  Personal Geodatabase).

 •  Straight Segment – vytváranie 
náčrtu (proces vytvárania prvku až 

Obrázok 29
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po jeho uloženie do vrstvy) priamym 
vkladaním uzlov, t. j. jedno kliknutie 
predstavuje jeden uzol (Vertex), ktorý 
je hranou (Edge) spojený s predchá-
dzajúcim uzlom (obrázok 30). 

 •  End Point Arc Segment – vytváranie 
náčrtu oblúkovou geometriou pomo-
cou umiestnenia začiatočného a kon-
cového bodu. Stlačením klávesy „R“ 
definujeme polomer (obrázok 31). 

 •  Bezier Curve Segment – vytváranie 
náčrtu pomocou Bézierovej krivky, t. j. 
interaktívne modelovanie tvaru krivky 
pomocou uhla viazaného k začiatočné-
mu a koncovému bodu, ktorý je záro-
veň aj kontrolným (obrázok 32).

 •  Direction-Distance – vytváranie 
náčrtu, resp. jeho pokračovanie zade-
finovaným smerom a vzdialenosťou od 
posledného alebo začiatočného uzla. 
Stlačením klávesy „D“ definujeme smer 
alebo vzdialenosť (obrázok 33). 

 •  Distance-Distance – vytváranie ná-
črtu, resp. jeho pokračovanie prieni-
kom dvoch bodov, ktoré majú defino-
vané vzdialenosti. Stlačením klávesy 
„D“ definujeme vzdialenosť (obrázok 
34). 

 •  Arc Segment – vytváranie náčrtu 
v tvare pravidelného oblúka od začia-
točného bodu, následným klik nutím 
definujeme koncový bod, ktorý je po-
súvateľný (na rozdiel od nástroja  
End Point Arc Segment), čím sa mení 
aj polomer oblúka. Stlačením klávesy 
„R“ definujeme polomer (obrázok 35).

Obrázok 34

Obrázok 33

Obrázok 32

Obrázok 31

Obrázok 30
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 • Intersection – vytváranie alebo po-
kra čo vanie náčrtu podľa generovaného 
prie niku dvoch línií, ktoré prichytáva-
me k existujúcim prvkom (obrázok 
36). 

 •  Midpoint – pomocnou líniou, ktorá 
pozostáva z dvoch bodov (začiatočný 
a koncový), sa vygeneruje jej stred, t. j. 
ďalší uzol pri vytváraní náčrtu (obrázok 
37).

 •  Right Angle – vytváranie pravého 
uhla medzi dvoma hranami, ktoré spája 
jeden uzol (obrázok 38).

 •  Tangent – umožňuje vytvárať pra-
videlný oblúk v smere ku koncovému 
uzlu, resp. k predchádzajúcemu uzlu. 
Nástroj je vhodné použiť počas tvorby 
už existujúcej časti náčrtu, t. j. pri po-
kračovaní procesu tvorby prvku (obrá-
zok 39). 

 •  Trace – vytváranie náčrtu na základe 
existujúcej geometrie už vytvorených 
prvkov (obrázok 40).

 •  Point – vytváranie bodových prv-
kov. 

 •  Edit Vertices – modifikácia geomet-
rie existujúceho prvku. Po výbere ná-
stroja sa prvok zmení na náčrt a zobra-
zí sa ďalšia lišta (obrázok 41) s názvom 
Edit Vertices.

 •  Modify Sketch Vertices – modi-
fikácia tvaru prvku, resp. náčrtu, 
prostredníctvom zmeny polohy 
jeho uzlov a hrán (obrázok 42),

 •  Add Vertex – priame pridanie 
uzla na zvolené miesto hrany prv-
ku,

Obrázok 39

Obrázok 38

Obrázok 37

Obrázok 36

Obrázok 35



35

 •  Delete Vertex – priame odstráne-
nie vybraného uzla z hrany prvku,

 •  Continue Feature Tool – po-
kračovanie v editovaní geometrie 
prvku, napr. vytváranie vnútorných 
výrezov, tzv. prstencových útvarov 
(obrázok 43),

 •  Sketch Proportionately – pro-
porcionálna zmena veľkosti prvku, 
t. j. zachovanie pomeru strán (obrá-
zok 44),

 •  Finish Sketch – ukončenie modi-
fikácie prvku ako celku,

 •  Sketch Properties – zobrazí sa 
okno v bočnom paneli s vlastnosťa-
mi jednotlivých uzlov, ktoré je mož-
né modifikovať.

Ku každému uzlu je možné zobraziť 
kontextové menu (obrázok 45), ktoré 
ponúka položky Delete Vertex (od-
stránenie uzla), Move (premiestnenie 
uzla o hodnotu jednotiek nastavených 
v dátovom ráme resp. kartografickom 
zobrazovacom systéme), Move To 
(premiestnenie uzla na zadané X, Y 
súradnice), Part → Select All Vertices 
(výber všetkých uzlov v modifikova-
nom prvku), Delete Sketch (odstrá-
nenie celého náčrtu),  Finish Sketch 
(ukončenie modifikácie náčrtu), Finish 
Part (ukončenie editovania časti ná-
črtu, napr. vnútorného výrezu prvku), 

 Sketch Properties (zobrazí sa okno 
v bočnom paneli so súradnicovými 
vlastnosťami jednotlivých uzlov).

Tak ako pri uzloch, aj k jednotlivým 
hranám je možné zobraziť kontexto-
vé menu (obrázok 46), ktoré ponúka 
položky Insert Vertex (pridanie uzla 
na zvolené miesto hrany), Change 
Segment → Circular Arc (obrázok 
47 – zmena zvolenej hrany na kruho-
vý oblúk s možnosťou ďalšej úpravy), 

Obrázok 41

Obrázok 42

Obrázok 43

Obrázok 44

Obrázok 45

Obrázok 40
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Change Segment → Bezier (obrázok 
48 – zmena zvolenej hrany na Béziero-
vú krivku s možnosťou ďalšej úpravy).

 •  Reshape Feature Tool – zmena tva-
ru (obrázok 49) vybraného líniového 
(priebeh línie) alebo polygónového 
prvku (pridanie alebo odobranie plo-
chy).

 •  Cut Polygons Tool – rozdelenie vy-
braného plošného, resp. poly gó nového 
prvku na minimálne dve časti (obrázok 
50). Každý novovzniknutý prvok si za-
chová hodnoty atribútovej tabuľky pô-
vodného prvku. 

 •  Split Tool – rozdelenie vybraného 
líniového prvku na minimálne dve čas-
ti (obrázok 51). Všetky novovzniknuté 
prvky si zachovajú hodnoty atribútovej 
tabuľky pôvodného prvku.

 •  Rotate Tool – otáčanie prvkov (obrá-
zok 52) o ľubovoľný uhol alebo o pres-
ne zadanú hodnotu v dialógovom okne, 
ktoré sa zobrazí stlačením klávesy „A“. 

 •  Attributes – zobrazenie atribútových 
záznamov k vybraným prvkom (obrá-
zok 53). Jednotlivé atribútové hodnoty 
je možné modifikovať, zoraďovať a zo-
brazovať k nim ďalšie parametre.

 •  Sketch Properties – v bočnom pane-
li sa k vybranému prvku zobrazí okno 
s polohovými vlastnosťami jednotli-
vých uzlov, ktoré je možné modifikovať, 
resp. posúvať na iné súradnicové hod-
noty (obrázok 54). Ku každej položke 
môžeme zobraziť kontextové menu:

Insert Before  • – vloženie nového 
uzla na stred hrany pred vybraný 
uzol,

Insert After  • – vloženie nového uzla 
na stred hrany za vybraný uzol,

Obrázok 52

Obrázok 51

Obrázok 50

Obrázok 49

Obrázok 48

Obrázok 47

Obrázok 46
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Flash  • – animované zvýraznenie vybraného uzla,

Zoom To  • – priblíženie k vybranému uzlu v mapovom okne,

 • Pan To – zobrazenie uzla v aktuálnej mierke do stredu mapového okna,

Delete  • – odstránenie vybraného uzla.

 •  Create Features – výber cieľovej vrstvy a štýlu, resp. konštrukčnej geometrie, 
podľa ktorej budeme vytvárať prvky. Výber vrstvy sa realizuje v prvej časti okna 
(obrázok 55). V druhej časti okna máme k dispozícii konštrukčné nástroje, t. j. 
konkrétnu šablónu (geometrický útvar) na vytváranie prvkov. 

V prípade polygónových prvkov máme k dispozícii:

 •  Polygon – prvky bez geometrických obmedzení, t. j. plošný útvar s minimálnym 
počtom dvoch uzlov;

 •  Rectangle – prvky s obdĺžnikovou alebo štvorcovou geometriou, t. j. plošný útvar 
s pravým uhlom na rozhraní uzla a dvoch hrán;

 •  Circle – prvky s kruhovou geometriou, t. j. plošný kruhový útvar. Stlačením kláve-
sy „R“ je možné zadať polomer;

 •  Elipse – prvky s elipsovou geometriou, t. j. plocha v tvare elipsy. Stlačením kláve-
sy „R“ je možné zadať uhol pre hlavnú a vedľajšiu os;

 •  Freehand – prvky s plošnou geometriou, kde priebeh vytvárania je závislý na voľ-
nom pohybe myšou;

 •  Auto Complete Polygon – polygónové prvky s automatickým dokončením v sme-
re k existujúcemu prvku, ktorý je však k nemu východiskovým;

 •  Auto Complete Freehand – polygónové prvky v kategórii Freehand s automatic-
kým dokončením k existujúcemu prvku, ktorý je však k nemu východiskovým.

Obrázok 53 Obrázok 54
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V prípade líniových prvkov máme k dispozícii:

 •  Line – prvky bez geometrických obmedzení, t. j. líniový útvar s minimálnym poč-
tom dvoch uzlov a jednej hrany,

 •  Rectangle – prvky s obdĺžnikovou alebo štvorcovou geometriou, t. j. líniový útvar 
uzatvorený do obdĺžnika alebo štvorca,

 •  Circle – prvky s kruhovou geometriou, t. j. líniový kruhový útvar, kde pri stlačení 
klávesy „R“ je možné zadať polomer,

 •  Elipse – prvky s elipsovou geometriou, to znamená línie v tvare elipsy, kde pri 
stlačení klávesy „R“ je možné zadať polomer pre hlavnú a vedľajšiu os,

 •  Freehand – prvky s líniovou geometriou, kde priebeh vytvárania prvku je závislý 
na voľnom pohybe myšou.

V prípade bodových prvkov máme k dispozícii:

 •  Point – bodové prvky bez obmedzení,

 •  Point at end of line – bodové prvky na konci pomocnej línie.

Počas procesu editovania náčrtu je možné zobraziť kontextové menu s nasledovným roz-
sahom nástrojov (obrázok 56):

 • Snap To Feature – prichytenie uzla k najbližšiemu koncovému bodu (Endpoint), uzlu 
(Vertex), k stredovému bodu (Midpoint) hrany alebo k samostatnej hrane (Edge) 
prvku, ku ktorému sme zobrazili kontextové menu;

 • Direction – definovanie smeru (v uhloch) na vytvorenie ďalšieho uzla;

 • Deflection – definovanie smeru (v uhloch) na vytvorenie ďalšieho uzla v nadväznos-
ti na polohu predchádzajúceho uzla či hrany;

 • Length – definovanie vzdialenosti ďalšieho uzla od súčasného uzla;

Obrázok 55 Obrázok 56
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 • Change Length – zmena dĺžky definovanej vzdialenosti (Length), t. j. smer uzla, resp. 
smer budúcej hrany je zachovaný, mení sa len dĺžka hrany voľným pohybom myši;

 • Absolute X, Y – vytvorenie ďalšieho uzla na základe presne definovaných súradníc 
X a Y;

 • Delta X, Y – vytvorenie ďalšieho uzla na základe presne definovanej vzdialenosti od 
súčasného umiestnenia uzla;

 • Direction/Length – vytvorenie ďalšieho uzla kombináciou smeru a dĺžky od súčas-
ného uzla;

 • Parallel – na vytváranie ďalšieho uzla definujeme súbežný smer ako má hrana prvku, 
ku ktorému sme zobrazili kontextové menu;

 • Perpendicular – ďalší uzol, resp. jeho smer, je kolmý na smer hrany prvku, ku ktorej 
sme zobrazili kontextové menu;

 • Segment Deflection – definovanie smeru (pomocou uhla) ďalšieho uzla od hrany 
prvku, ku ktorému sme zobrazili kontextové menu;

 • Replace Sketch – zmena geometrie prvku, napr. skopírujeme a zmeníme polygónový 
prvok na prvok s líniovou geometriou;

 • Tangent Curve – vytváranie kruhového oblúka smerom k súčasnému uzlu;

 • Streaming – pri voľnom pohybe myšou sa automaticky umiestňujú uzly. Štandardné 
vkladanie uzlov je vypnuté;

 • Delete Sketch – odstránenie vytváraného náčrtu;

 •  Finish Sketch – ukončenie vytvárania náčrtu, čím docielime vytvorenie prvku;

 • Square and Finish – náčrt sa uzavrie do obdĺžnikového tvaru a následne sa ukončí 
jeho vytváranie;

 • Finish Part – ukončenie vytvárania časti náčrtu s možnosťou ďalšieho pokračovania, 
napr. vnútorné výrezy alebo zmena tvaru prvku.

4 .2 . Lišta Editor – padajúce menu Editor
Padajúce menu lišty Editor ponúka nástroje na spustenie, ukončenie a priebežné uklada-

nie procesu editácie, základné geoprocesingové nástroje a spektrum líšt s rozšírenými mož-
nosťami editácie prvkov.

1 .  Start Editing – ako už bolo spomínané, ide o spustenie procesu editácie, resp. 
prepnutie aplikácie ArcMap do tzv. editovateľného módu.

2 .  Stop Editing – ukončenie procesu editácie, t. j. uloženie vykonanej tvorby alebo 
úpravy prvkov.

3 .  Save Edits – priebežné ukladanie tvorby alebo úpravy prvkov bez toho, aby sme 
ukončili proces editácie.

Move4 .  – posunutie vybraného prvku na základe presne definovanej vzdialenosti 
v smere osi X a Y od súčasnej polohy prvku.

5 . Split – rozdelenie línie podľa zadaných hodnôt (obrázok 57):
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definovanej vzdialenosti ( • Distance) od prvého uzla línie (From Start Point of 
Line) alebo od posledného uzla línie (From End Point of Line), napr. 50 m;

definovaných intervalov ( • Into Equal Parts), napr. po 20 m;

rozdelenie línie percentuálnym pomerom ( • Percentage) od prvého uzla línie 
(From Start Point of Line) alebo od posledného uzla línie (From End Point of 
Line), napr. 35 %.

6 .  Construct Points – podľa zadaných hodnôt a vybranej línie vytvoríme bodové 
prvky, resp. bodovú vrstvu (obrázok 58):

definovanú počtom bodov ( • Number of Points) s možnosťou pridať bod na začiat-
ku a na konci línie (Create additional points at start and end), napr. 50 bodov;

definovanú vzdialenosťou medzi bodmi ( • Distance) s možnosťou pridať bod na 
začiatku a konci línie (Create additional points at start and end) a definovanú 
orientáciou od prvého uzla línie (From Start Point of Line) alebo od posledného 
uzla línie (From End Point of Line), napr. 20 m.

7 .  Copy Parallel – rovnobežné kopírovanie líniového prvku podľa (obrázok 59): 

výberu štýlu, resp. šablóny ( • Template), pomocou ktorej sa vytvoria (skopírujú) 
nové prvky;

definovanej vzdialenosti ( • Distance) na umiestnenie skopírovaného prvku, napr. 
20 m;

výberu smeru, resp. strany ( • Side), do ktorej sa bude prvok kopírovať. Možnosť 
Both (z padajúceho menu) ponúka kopírovanie prvku do obidvoch strán. Mož-
nosťami Left alebo Right vybraný prvok rovnobežne skopírujeme buď do jeho 
pravej alebo ľavej strany; 

definovaného typu zaoblenia lomových bodov (uzlov) skopírovaných prvkov.  •
K dispozícii máme možnosť Bevelled (uhly medzi hranami sú skosené), Mitered 
(pôvodné uhly medzi hranami) a Rounded (uhly medzi hranami sú zaoblené).

Obrázok 58Obrázok 57
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V prípade línie, ktorá má viacero častí, môžeme využiť voľbu Treat selection as 
a single line, t. j. jednotlivé časti línie budú vstupovať do kopírovania ako jedna sú-
vislá línia. Pri voľbe Create a new feature for each selected line bude na výstupe 
toľko samostatných častí ako na vstupe, a to bez zmeny ich vzájomného umiestnenia. 
Voľba Remove self-intersecting loops umožňu-
je odstrániť prípadné vzájomné prekrývanie.

8 . Merge – spájanie minimálne dvoch vybraných 
prvkov (vstupné prvky) do jedného prvku 
(výstupný prvok). Výstupný prvok má v sebe 
obsiahnutý vonkajší priebeh hraníc vstupných 
prvkov a atribútové hodnoty jedného z vybra-
ných prvkov (obrázok 60).

9 .  Buffer – vytváranie tzv. obalových zón pod-
ľa definovanej vzdialenosti a štýlu, do ktorého 
sa bude nový prvok (obalová zóna) vytvárať 
(obrázok 61).

10 . Union – spájanie minimálne dvoch vybraných 
prvkov (vstupné prvky) do jedného prvku 
(výstupný prvok). Ide o podobný nástroj ako 
Merge, len bez možnosti výberu atribútových 
hodnôt.

11 . Clip – orezanie alebo zachovanie polygóno-
vého prvku, ktorý je vo vzájomnom prieniku 
s vybraným prvkom podľa nasledovnej špeci-
fikácie (obrázok 62): 

veľkosť orezanej alebo zachovanej plochy,  •
ktorá má zadanú vzdialenosť (Buffer Dis-
tance), napr. v rozsahu 5 m;

Obrázok 60

Obrázok 61

Obrázok 59
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orezanie plochy vo vzájomnom prieniku ( • Discard the area that intersects), napr. 
vo vzdialenosti 5 m od vybraného prvku bude vytvorený výrez. V prípade zada-
nia vzdialenosti s hodnotou 0 vytvoríme tzv. topologický výrez. Obidve vrstvy, 
ktoré sú vo vzájomnom prieniku, nebudú mať medzi sebou prázdne miesto a ne-
budú sa vzájomne prekrývať; 

zachovanie plochy vo vzájomnom prieniku ( • Preserve the area that intersects), 
napr. vo vzdialenosti 5 m od vybraného prvku bude ponechaná plocha z celého 
polygónového prvku. 

Options 12 . – nastavenie procesu editácie, t. j. tolerančných hodnôt pohybu kurzora 
myšou, farebná symbológia editovaných prvkov a popisov (anotácií), pracovné jed-
notky, možnosti zobrazenia atribútových záznamov, upozornení, varovaní atď. Jed-
notlivé možnosti nastavení sú štruktúrované v záložkách General, Topology, Ver-
sioning, Units, Annotation a Attributes.

V padajúcom menu Editor sa nachádzajú aj položky na spustenie ďalších líšt, ktorými sa 
rozširuje funkcionalita editovania v ArcMap. Niektoré lišty si v nasledujúcom texte postup-
ne predstavíme. 

4 .3 . Lišta Snapping
Lišta s obsahom nástrojov (obrázok 63), ktoré sú určené na prichytávanie vytváraného 

alebo modifikovaného prvku k existujúcim prvkom alebo k náčrtu. Lištu Snapping môžeme 
spustiť v hlavnom menu Customize → Toolbars → Snapping alebo v padajúcom menu lišty 
Editor položkou Snapping → Snapping Toolbar.

Na lište Snapping sú umiestnené 4 základné nástroje a padajúce menu s názvom 
Snapping. Nástroje ponúkajú nasledovné možnosti:

1 .  Point Snapping – prichytávanie na prvky s bodovou geometriou,

2 .  End Snapping – prichytávanie na koncové uzly vytvorených prvkov,

3 .  Vertext Snapping – prichytávanie na všetky uzly vytvorených prvkov, vrátane kon-
cového uzla,

4 .  Edge Snapping – prichytávanie na hrany vytvorených prvkov.

 Padajúce menu Snapping obsahuje nasledovné položky:

Obrázok 62 Obrázok 63
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1 . Use Snapping – aktivácia a deaktivácia nástrojov prichytávania počas procesu edi-
tovania,

2 .  Intersection Snapping – prichytávanie na bod vzájomného prieniku dvoch prv-
kov,

3 .  Midpoint Snapping – prichytávanie na stredový bod hrany vytvorených prvkov,

4 .  Tangent Snapping – prichytávanie na uhol zakrivenej línie v bode, kde vzniká 
dotyčnica s hranou vytváraného prvku,

5 . Snap to Sketch – prichytávanie na hranu a uzly náčrtu za tej podmienky, že  Vertex 
Snapping a  Edge Snapping sú aktívne,

Snap to 6 . Topology Nodes – prichytávanie na topologické uzly počas vytvárania prvku 
za tej podmienky, že nástroj  Point Snapping je aktívny,

Options7 .  – v okne s názvom Snapping Options môžeme nastaviť základné paramet-
re prichytávania počas procesu editácie. Ide hlavne o nastavenie tolerancie, farebnej 
symbológie prichytávanej časti prvku, o nastavenie možnosti prichytávania na pod-
kladovú mapu, upozornenia na typy a triky atď. 

4 .4 . Lišta Advanced Editing
Lištu Advanced Editing môžeme spustiť v hlavnom menu Customize → Toolbars → 

Advanced Editing alebo prostredníctvom padajúceho menu lišty Editor a položky More 
Editing Tools → Advanced Editing. Jednotlivé nástroje lišty Advanced Editing sprístupní-
me rovnakým spôsobom (obrázok 64) ako pri lište Editor, t. j. spustenie procesu editovania 
položkou  Start Editing. Lišta Advanced Editing ponúka nasledovný súbor nástrojov: 

 
Obrázok 64

 
Obrázok 65

1 .  Copy Feature Tool – nástroj skopíruje požadovaný výber prvkov a vloží do presne 
zadefinovaného priestoru (obrázok 65). K dispozícii sú dve formy kopírovania a ná-
sledného vkladania:

so zachovaním veľkostného pomeru vybraných  •
prvkov, t. j. kliknutím myšou na zvolené miesto,

bez zachovania veľkostného pomeru vybraných  •
prvkov, t. j. prostredníctvom tzv. okna výberu, 
ktorým vložíme skopírované prvky do definova-
nej veľkosti priestoru.

2 .  Fillet Tool – zmena vybranej časti línie na oblúko-
vý útvar (obrázok 66) pomocou tzv. dvoch kotviacich 

Obrázok 66
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bodov (dotyčníc). Stlačením klávesy „O“ sa zobrazí dialógové okno, v ktorom sa 
definuje uhol a nachádza sa voľba na ponechanie alebo odstránenie pôvodnej časti 
prvku. 

3 .  Extend Tool – predĺženie vybranej línie o dĺžku prieniku k ďalšej vybranej línii.

4 .  Trim Tool – skrátenie vybranej línie k najbližšiemu prieniku s ďalšou vybranou 
líniou.

5 .  Line Intersection – rozdelenie vybraných línií na menšie úseky v mieste ich vzá-
jomného prieniku. Ide o nástroj, ktorým je možné časti prvkov deliť, ale aj dopĺňať 
do vzájomného prieniku. Stlačením klávesy „O“ sa zobrazí dialógové okno, v kto-
rom definujeme buď rozšírenie existujúceho prvku do vzájomného prieniku (Ex-
tend existing feature), alebo pridanie nového prvku tak, aby sa vytvoril vzájomný 
prienik (Add a new feature).

6 .  Explode Multipart Feature – rozdelenie 
niekoľkých prvkov, ktoré sú previazané jed-
ným atribútovým záznamom (riadok v atri-
bútovej tabuľke), na prvky so samostatným 
atribútovým záznamom. 

7 .  Construct Geodetic – vytváranie prvkov 
na základe definovaných súradnicových 
hodnôt.

8 .  Align To Shape – prostredníctvom defi-
novanej vzdialenosti môžeme zarovnať vy-
braný prvok, resp. upraviť jeho polohu uzlov 
k polohe uzlov cieľového prvku. 

9 .  Replace Geometry Tool – zmena tvaru 
polygónu bez možnosti individuálnej úpravy 
uzlov alebo hrán tak, ako je to možné pri ná-
stroji  Edit Vertices lišty Editor.

10 .  Construct Polygons – zmena líniového 
prvku na polygónový prvok, avšak za tej 
podmienky, že línia má uzatvorený tvar, t. j. 
koncový uzol sa prekrýva so začiatočným.

11 .  Split Polygons – rozdelenie polygónových 
prvkov prostredníctvom ich vzájomného 
prieniku pomocou vybranej línie alebo línií 
(obrázok 67).

12 .  Planarize Lines – automatizované rozdele-
nie vybraných línií na menšie úseky v mieste 
ich vzájomného prieniku (obrázok 68). Pred 
vykonaním tejto operácie je možné zadať tzv. 
tolerančnú hodnotu vyhľadávania ich vzá-
jomných prienikov (Cluster Tolerance). 

Obrázok 70

Obrázok 69

Obrázok 68

Obrázok 67
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13 .  Generalize – zjednodušenie geometrie vybraných líniových alebo polygónových 
prvkov prostredníctvom zadania maximálnej možnej vzdialenostnej odchýlky od 
pôvodnej geometrie prvku (obrázok 69). Generalizáciou, t. j. zjed nodušovaním geo-
metrie, dochádza k redukcii počtu uzlov.

14 .  Smooth – vyhladenie geometrie prvkov pomocou princípu, ktorý sa uplatňuje pri 
tvorbe Bézierovej krivky (obrázok 70). 

4 .5 . Lišta Spatial Adjustment
Lišta Spatial Adjustment ponúka súbor nástrojov, ktorými môžeme priestorovo meniť 

polohu vektorových prvkov (obrázok 71). Ide o posun prvkov zo súčasnej polohy na zada-
nú novú polohu. Spôsob priestorového prispôsobenia polohy prvkov spočíva v definovaní 
zdrojového bodu a v označení cieľového bodu (obrázok 72).

       
Obrázok 71

       
Obrázok 72

Zmenu polohy prvkov je možné vykonať, len ak máme spustený proces editovania 1 . 
a vybraný daný prvok alebo prvky.

Definovanie zdrojového bodu sa realizuje výberom konkrétnej časti prvku, napr. za-2 . 
čiatočným alebo koncovým bodom línie. Cieľový bod je miestom, resp. polohou, 
kam chceme daný bod presunúť. Vždy je potrebné definovať zdroj toho, čo chceme 
presunúť a cieľ, kam chceme daný bod umiestniť, teda medzi dvomi bodmi vytvára-
me určité prepojenie – linku. Výber zdrojového bodu a cieľovej polohy realizujeme 
nástrojom  New Displacement Link Tool. Na zmenu definovanej linky využívame 
nástroj  Modify Link. Hromadné prepojenie medzi zdrojom a cieľom sa realizuje 
nástrojom  Multiple Displacement Link Tool. 

V padajúcom menu lišty 3 . Spatial Adjustment máme k dispozícii položku Adjustment 
Methods, ktorá obsahuje niekoľko metód na zmenu polohy prvkov. Výber správnej 
metódy priamo ovplyvňuje výsledok posunu. Niektoré metódy menia len veľkosť 
a polohu prvku, niektoré aj tvar prvku.

Samotný posun sa uskutočňuje pomocou nástroja 4 .  Adjust v padajúcom menu lišty 
Spatial Adjustment. 
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4 .6 . Lišta Topology
Lišta Topology ponúka široké spektrum nástrojov, ktorými môžeme upravovať, prípadne 

opravovať priestorové vzťahy medzi prvkami (obrázok 73). Základným pravidlom je, aby sa 
prvky jednej vrstvy medzi sebou neprekrývali. Zároveň ak prvky jednej vrstvy majú súvisle 
vyplniť určitý priestor, nesmú medzi sebou vytvárať prázdne miesta.

          
Obrázok 73

          
Obrázok 74

Aplikácia ArcMap poskytuje priame aj nepriame nástroje topologických úprav. Medzi 
nepriame patria tzv. „logickí operátori“ ako kombinácia nástrojov procesu editácie a pou-
žívateľského prístupu pri ich aplikácii. Ide napr. o rozdeľovanie prvkov na menšie časti, ich 
spájanie alebo dokončovanie (  Cut Polygons Tool,  Auto Complete Polygon,  Extend 
Tool,  Trim Tool,  Line Intersection,  Align To Shape atď.).

Nástroje priamych topologických úprav sa nachádzajú na lište Topology. Funkcionalita 
nástrojov závisí od nainštalovanej verzie ArcGISu, ďalej od typu geodatabázy, resp. súbo-
rového formátu, v ktorom sú uložené prvky. V prípade súborového formátu .shp je rozsah 
funkcionality nasledovný:

1 .  Select Topology – výber vrstiev, ktoré budú predmetom topologických úprav. 

2 .  Topology Edit Tool – pomocou okna výberu môžeme vybrať prvky a ich hrany, 
ktoré budú predmetom topologických úprav (obrázok 74). 

3 .  Topology Edit Trace – výber hrany prvku topologických úprav jej líniovým ko-
pírovaním.

Po výbere prvku, ktorý bude predmetom topologických úprav, musíme dvojklikom 4 . 
spustiť tzv. editovateľný mód. Následne sa zobrazia uzly na vybranej línii a aktivujú 
ďalšie dostupné nástroje lišty Topology.

5 .  Modify Edge – nástroj s rovnakými funkciami ako nástroj  Edit Vertices na lište 
Editor. Avšak spoločné uzly a hrany dvoch prvkov sú aj po úpravách vo vzájomnom 
topologickom vzťahu. Počas úprav medzi prvkami nevznikajú prázdne miesta, ani 
nedochádza k ich vzájomnému prekrývaniu. 

6 .  Reshape Edge Tool – nástroj s rovnakými funkciami ako  Reshape Feature Tool 
na lište Editor. Použitím nástrojov z lišty Topology zachovávame topologické vzťahy 
medzi prvkami.

7 .  Align Edge Tool – nástroj určený na opravu topologických chýb. Ak medzi prv-
kami existuje prázdne miesto alebo sa prvky vzájomne prekrývajú, vybranú hranu 
(zmena prerušovanej čiary na plnú) môžeme topologicky zarovnať (výber hrany 
prerušovanou čiarou) k hrane ďalšieho prvku. Rovnakú funkcionalitu má nástroj  
Align To Shape z lišty Advanced Editing.
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8 .  Generalize Edge – zjednodušenie geometrie vybraných hrán. Ide o generalizá-
ciu počtu uzlov, ktoré sa vzájomne prekrývajú alebo sú medzi nimi prázdne miesta. 
Rovnakú funkcionalitu, ale bez dôrazu na topologické pravidlá, má aj nástroj  
Generalize z lišty Advanced Editing.

9 .  Shared Features – okno v bočnom paneli so zoznamom prvkov, ktoré sú vybrané 
na topologické úpravy.

Ostatné nástroje lišty 10 . Topology sú určené na prácu s topologickými pravidlami 
v geo databázovom rozhraní. 

Prostredie aplikácie ArcMap umožňuje využívať aj ďalšie lišty a nástroje v procese edi-
tácie. Použiteľnosť nástrojov, ktoré nie sú opísané v tejto kapitole, podlieha špecifickej apli-
kačnej úrovni alebo prostrediu, v ktorom sa jednotlivé nástroje používajú. Opísaný rozsah 
nástrojov v tejto kapitole ponúka používateľovi základný prehľad možností tvorby a úprav 
geografických informácií. 

Otázky:

Ktorá z dostupných líšt aplikácie ArcMap sa používa na tvorbu a úpravu 1. 
geografických informácií?

Ktoré konštrukčné nástroje je možné použiť pri tvorbe polygónovej 2. 
vrstvy geografických informácií?

Aké nástroje ponúka lišta Snapping?3. 

Aký je rozdiel medzi nástrojmi 4. Generalize a Smooth z lišty Advanced 
Editing?

Aký je účel nástrojov, ktoré sa nachádzajú na lište 5. Spatial Adjustment?

Ktoré sú priame nástroje topologických úprav geometrie prvkov vrstiev 6. 
geografických informácií?
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5 . Transformácia geografickej polohy
Geografická poloha objektov na zemskom povrchu je daná geografickými súradnicami 

[λ, φ] (geografická dĺžka a geografická šírka). Kartografická poloha je daná kartografickými 
súradnicami [x, y] konkrétneho kartografického zobrazenia. V rámci tejto kapitoly sú ter-
míny „geografické“ a „kartografické“ synonymami.

Geografická poloha je základným elementom, ktorý geografické údaje odlišuje od ostat-
ných typov údajov. Prostredie aplikácie ArcMap ponúka široké spektrum nástrojov na prácu 
s geografickou polohou, t. j. umiestnenie a zmena polohy prvkov, zmena kartografického 
zobrazovacieho systému, pripojenie ku GNSS externým zariadeniam atď. 

Všeobecný princíp umiestnenia rastrovej vrstvy geografických informácií do súradni-
covo správnej geografickej polohy (hovoríme tomu georeferencovanie, resp. registrácia) vy-
chádza z parity dvoch (prípadne viacerých) kontrolných bodov, t. j. zdrojový bod a cieľový 
bod (obrázok 75). Pri umiestňovaní rastrovej vrstvy (naskenovaná mapa) je vždy potrebné 
zadať najprv zdrojový bod (identifikovaný v skenovanom rastri ) a potom cieľový bod (iden-
tifikovaný napr. číselne súradnicami alebo kliknutím na korektnú polohu v definovanom 
súradnicovom priestore). Zdrojový a cieľový bod sú totožné miesta, len dovtedy v rôznych 
priestoroch. Zdrojový bod je v priestore, ktorý vychádza z aktuálneho umiestnenia skeno-
vaného podkladu v mapovom okne editora (grafické umiestnenie). Cieľový bod je miesto 
definované presnou geografickou polohou (geografické umiestnenie).

Obrázok 75
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5 .1 . Lišta Georeferencing
Zobrazenie, resp. korektné priestorové umiestnenie vrstiev geografických informácií, sa 

v aplikácii ArcMap vykonáva prostredníctvom geografickej polohy, ktorá je k daným dátam 
priradená. Lišta s názvom Georeferencing ponúka nástroje na prácu, zmenu alebo prirade-
nie geografickej polohy k rastrovým dátam. 

Lištu 1 . Georeferencing môžeme zobraziť v položke hlavné menu Customize → Tool-
bars → Georeferencing. 

Práca s lištou si vyžaduje zdrojové údaje, t. j. v okne obsahu musíme mať k dispozí-2 . 
cii rastrové dáta (napr. naskenovaná mapa), ktorým budeme meniť alebo priraďovať 
geografickú polohu. 

V padajúcom menu lišty 3 . Georeferencing si zvolíme vrstvu geografických informá-
cií (rastrový súbor), ktorej budeme definovať geografické umiestnenie (polohu). 
V ponuke budeme mať len vrstvy, ktoré sa nachádzajú v okne obsahu (obrázok 76). 
Rastrová vrstva bez priradenej geografickej polohy je štandardne umiestnená pod-
ľa svojho rozlíšenia, t. j. počtu pixlov v riadkoch a stĺpcoch.

Obrázok 76

Obrázok 77

Lišta 4 . Georeferencing ponúka niekoľko nástrojov, ktoré sú umiestnené buď v padajú-
com menu Georeferencing alebo na samotnej lište. V padajúcom menu sa nachádza 
nasledovné spektrum nástrojov (obrázok 77): 

4 .1 . Update Georeferencing – k zdrojovému súboru sa vytvorí tzv. georeferenčný 
„WORLD FILE“ súbor, v ktorom budú uložené číselné údaje o geografickom 
umiestnení georeferencovanej vrstvy. Podľa uvedeného súboru sa bude daná 
vrstva zobrazovať v presne vymedzenom geografickom priestore.

4 .2 . Rectify – uloženie zobrazenej vrstvy do nového súborového formátu, resp. geo-
databázy. 
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4 .3 . Fit To Display – zobrazenie vrstvy do veľkosti aktuálneho mapového okna.

4 .4 . Update Display – aktualizácia zobrazenej vrstvy podľa kontrolných bodov.

4 .5 . Auto Adjust – automatické umiestnenie vrstvy podľa posledného zadaného 
bodu. 

4 .6 . Flip or Rotate – prevrátenie (  horizontálne/  vertikálne) alebo otočenie vrstvy 
(  doprava/  doľava).

4 .7 . Transformation – výber algoritmu (metódy) premiestnenia obrázka, a to zo 
súčasného grafického umiestnenia na cieľové geografické umiestnenie. K dis-
pozícii máme nasledovné metódy transformácií:

 • Polynomial – metóda vychádza z algoritmu metódy najmenších štvorcov 
(Least-Squares Fitting – LSF). Ide o posun zo zdrojovej polohy (grafické 
umiestnenie) na cieľovú (geografickú), a to aj na úkor mierneho odklonu od 
polohy cieľových bodov. Počet kontrolných párov bodov (zadaný zdrojový 
bod a cieľový bod) musí byť: 

1 bod •  pre nultý rád transformácie (len posun) – Zero Order Polynomial 
(Shift),

3 body •  pre prvý rád transformácie (posun, rotácia, zmena mierky) – Or-
der Polynomial (Affine),

6 bodov •  pre druhý rád transformácie (kvadratická polynomická trans-
formácia) – 2nd Order Polynomial,

10 bodov •  pre tretí rád transformácie (kubická polynomická tran s-
formácia) – 3rd Order Polynomial.

Nižšie rady posunov majú tendenciu väčších rozdielov v presnosti umiest-
nenia zdrojových bodov na cieľové miesta. Zároveň však zachovávajú pô-
vodný tvar rastra. 

 • Adjust – metóda je založená na kombinácii polynomickej transformácie 
a interpolačných techník nepravidelnej trojuholníkovej siete (TIN – Trian-
gulated Irregular Network). Interpolačná technika spresňuje kontrolné 
body, t. j. zvyšuje presnosť umiestnenia zdrojových bodov na miesta cieľové-
ho určenia. Použitie metódy si vyžaduje minimálne tri kontrolné body.

 • Spline – transformačná metóda, ktorá vychádza z polynomických algorit-
mov. Avšak pri tejto metóde sú algoritmy polynomickej metódy delené na 
jednotlivé časti, čím je možné dosiahnuť presnejšie umiestnenie zdrojových 
bodov na cieľové miesta. Metóda si vyžaduje minimálne 10 kontrolných bo-
dov. Použitie ďalších kontrolných bodov môže zvýšiť celkovú presnosť trans-
formácie.

 • Projective Transformation – transformačná metóda vhodná pre produk-
ty diaľkového prieskumu Zeme. Použitie metódy si vyžaduje minimálne 4 
kontrolné body. 

Delete Control Points4 .8 .  – odstránenie všetkých kontrolných bodov. 

4 .9 . Reset Transformation – zrušenie vykonanej transformácie vrstvy.
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Na lište Georeferencing je umiestnený nasledovný rozsah nástrojov:

1 .  Add Control Points – pridanie kontrolných bodov, t. j. definovanie zdrojového 
a cieľového umiestnenia.

2 .  Auto Registration – automatická metóda umiestňovania zdrojového rastra k cie-
ľovej polohe na základe palety značiek, ktoré sa využívajú pri diaľkovom prieskume 
Zeme. 

3 .  Select Link – výber linky (väzby) medzi zdrojovým a cieľovým bodom, t. j. výber 
parity kontrolných bodov.

4 .  Zoom To Selected Link – zobrazenie cieľového kontrolného bodu na stred mapo-
vého okna.

5 .  Delete Link – odstránenie vybranej väzby medzi kontrolnými bodmi. 

6 .  Viewer – zobrazenie georeferencovanej vrstvy v samostatnom okne, kde sa nachá-
dzajú nástroje na zmenu veľkosti obsahu okna. V tomto prehliadači môžeme zadávať 
zdrojové body a v mapovom okne cieľové body (obrázok 78). 

7 .  View Link Table – zobrazenie tabuľky kontrolných bodov, resp. väzieb medzi 
zdrojovým a cieľovým kontrolným bodom (obrázok 79). 

Súbor nástrojov na otáčanie (8 .  Rotate), posun (  Shift) a zmenu veľkosti (  Sca-
le) georeferencovanej vrstvy. Pre numericky presnú definíciu geografickej polohy 
bodov opísanými nástrojmi je na lište Georeferencing priradené okno na vkladanie 
číselných hodnôt.

Obrázok 78
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Kvalitatívna interpretácia procesu georeferencovania je vyjadrená tzv. strednými kvad-
ratickými odchýlkami (Root Mean Square – RMS). Ide o rozdiel medzi umiestnením zdro-
jového bodu a zadanou cieľovou polohou. Túto odchýlku je možné eliminovať postupným 
pridávaním ďalších kontrolných bodov alebo opravou existujúcich kontrolných bodov. RMS 
sa často zamieňa s presnosťou georeferencovania, čo nie je to isté.

Obrázok 79

5 .2 . Nástroj Add XY Data
Nástroj umiestňuje geografické [λ, φ] alebo kartografické [X, Y a Z] súradnice geogra-

fickej polohy objektov z tabuľkovej podoby do vrstvy geografických informácií. Súradnice 
„λ, φ“ alebo „X, Y“ reprezentujú konkrétne miesto na zemskom povrchu. Súradnica „Z“ vy-
jadruje nadmorskú výšku daného miesta. Súradnice s geografickou polohou [λ, φ, z], resp. 
[X, Y a Z], najčastejšie získavame terénnym zberom prostredníctvom systémov GNSS.

Geografické súradnice presne určeného miesta (napr. Banskoštiavnická kalvária) môžu 
mať rôznu podobu záznamu:

šesťdesiatková číselná sústava v podobe geografickej dĺžky 18° [stupňov] 54’ [minút]  •
51.78” [sekúnd] a geografickej šírky 48° [stupňov] 27’ [minút] 41.26” [sekúnd],

desiatková číselná sústava v podobe geografickej dĺžky (súradnicová os X) 18.91438°  •
(stupňov) a geografickej šírky (súradnicová os Y) 48.46146° (stupňov).

Kartografické (rovinné karteziánske) súradnice objektov [X, Y, Z] sú spravidla číslami 
z oboru reálnych čísel a jednotkami sú metre [437100,43 m; 1257611,45 m; 726,33 m n. 
m.].

Zobrazenie súradníc z externého tabuľkového súboru sa realizuje pomocou nástroja Add 
XY Data, ktorý sa nachádza v hlavnom menu pod položkou File → Add Data →  Add 
XY Data. Tento nástroj umožňuje vkladať len číselné údaje v desiatkovej sústave. Prevody 
medzi šesťdesiatkovou a desiatkovou sústavou vykonávajú rôzne webové aplikácie. 

Po spustení nástroja 1 .  Add XY Data sa zobrazí dialógové okno (obrázok 80) s nie-
koľkými možnosťami, ktorými zadávame: 

Externú databázu, ktorá obsahuje záznamy v podobe riadkov (uložené číselné 1 .1 . 
hodnoty) a stĺpcov (atribútová štruktúra, t. j. stĺpce s hodnotami súradníc X, Y 
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a Z). Databáza môže byť v rôznych 
súborových formátoch, najčastejšie 
ide o súbory .dbf, .xls alebo tabuľky 
z geodatabáz. Vkladanie konkrétnej 
databázy sa realizuje položkou s ná-
zvom Choose a table from the map 
or browse for another table.

Súradnicovú paritu „X“, „Y“ a „Z“, 1 .2 . 
t. j. podľa atribútovej štruktúry zdro-
jovej databázy vyberieme do poľa X 
Field atribút „X“, do poľa Y Field 
atribút „Y“ a do poľa Z Field atribút 
„Z“. 

Kartografický zobrazovací systém, 1 .3 . 
ktorý zodpovedá súradniciam, zadá-
vame v časti dialógového okna s ná-
zvom Coordinate System of Input 
coordinates. V prípade terénneho 
zberu dát pomocou WGS84 pôjde 
o geografický súradnicový systém 
zaradený do kategórie Geographic 
Coordinate System → World → 
WGS84.

Do okna obsahu sa automaticky pridá nová položka s príponou 2 . Events. Ide len o do-
časný súbor, ktorý je potrebné uložiť (exportovať) na trvalý záznam do geodatabázy 
alebo do iného súborového formátu, napr. .shp súboru.

Export sa vykonáva v kontextovom menu k danej položke, kde vyberieme 3 . Data → 
Export Data. V zobrazených dialógových oknách Export Data a Saving Data vybe-
rieme cestu, resp. miesto uloženia, názov súboru a súborový typ.

5 .3 . Zmena zobrazovacieho systému – nástroj Project
Poloha geografických objektov sa ako pri mapách, tak aj v prostredí GIS, znázorňuje 

prostredníctvom rôznych typov kartografických zobrazení (v prostredí GIS označované ako 
kartografický zobrazovací systém) a k nim prináležiacich súradnicových systémov. Úloha 
kartografických zobrazení, tzn. mapových projekcií a súradnicových systémov, spočíva 
v procese „prenosu“ (transformácie, zmenšenia a generalizovania) geografických objektov 
reálneho sveta do „2D“ roviny v prostredí GIS.

Číselná interpretácia presnej polohy objektov sa vyjadruje prostredníctvom súradnico-
vých systémov, v GIS označovaných pod názvom „coordinate systems“. Súradnicový systém 
vyjadruje jednoznačné a presné určenie polohy objektov na referenčnom telese a jeho pre-
nesenom obraze na dvojrozmernú plochu.

Geografické informácie môžu byť uložené v rôznych kartografických zobrazovacích sys-
témoch. Aplikácia ArcMap vykonáva automatické prevody k systému, ktorý je nastavený pre 
aktuálny dátový rám (Data Frame).

Obrázok 80
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Vykonanie akejkoľvek geografickej transformácie medzi zobrazeniami je podmienené 
tým, aby daná vrstva mala v sebe integrovanú informáciu o známom kartografickom zo-
brazovacom systéme. Ide o základný krok pri vytváraní novej vrstvy v aplikácii ArcCatalog. 
V prípade absencie môžeme túto informáciu dodatočne pridať prostredníctvom položky 
vlastnosti vrstvy (aplikácia ArcCatalog).

Obrázok 81

Transformácia kartografického zobrazovacieho systému vektorových geografických in-
formácií sa realizuje nástrojom Project (obrázok 81), ktorý sa nachádza v aplikácii  Arc-
ToolBox v časti Data Management Tools → Projection and Transformation → Feature → 
Project. 

Zobrazené okno s názvom 1 . Project ponúka niekoľko logicky za sebou nasledujúcich 
možností vstupných a výstupných parametrov požadovanej transformácie.

Vrstvy, resp. údaje, ktoré chceme transformovať, sa vkladajú do časti okna s názvom 2 . 
Input Dataset or Feature Class. V časti s názvom Input Coordinate System (optio-
nal) sa nachádza kartografický zobrazovací systém, ktorý je priradený k transformo-
vaným dátam.

V časti okna s názvom 3 . Output Dataset of Feature Class definujeme umiestnenie 
a názov cieľového súboru s novým kartografickým zobrazovacím systémom. 

Nasledujúca časť s názvom 4 . Output Coordinate System je určená na výber požado-
vanej cieľovej transformácie, t. j. do ktorého zobrazovacieho systému budeme prevá-
dzať údaje. V možnostiach výberu sú dve kategórie kartografických zobrazovacích 
systémov:
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4 .1 . Geographic Coordinate System – geografický zobrazovací systém vyjadruje 
polohu daného objektu na referenčnom telese prostredníctvom geografickej 
šírky a dĺžky. Geografická šírka predstavuje uhol, ktorý sa meria od rovníka 
k pólom v stupňoch (0° až 90°). Smerom na juh ide o južnú geografickú šírku, 
smerom na sever o severnú geografickú šírku. Geografická dĺžka predstavuje 
uhol medzi základným a miestnym poludníkom. Základným poludníkom (t. j. 
nultým poludníkom) je Greenwich (Anglicko) a vzdialenosť od neho sa udáva 
v stupňoch (0° až 180°). Smerom na východ ide o východnú geografickú dĺžku, 
smerom na západ o západnú geografickú dĺžku.

4 .2 . Projected Coordinate System – projekčný zobrazovací systém sa používa na 
vyjadrenie polohy objektov v dvojrozmernom rovinnom priestore. Mnoho geo-
grafických údajov je zobrazených a interpretovaných na dvojrozmernej ploche 
(papier, mapa, plocha obrazovky atď.), kde je ich poloha vyjadrená práve pro-
jekčným súradnicovým systémom, tzv. prienikom súradnicovej osi X a Y.

Časť s názvom 5 . Geographic Transformation (optional) je určená na výber konkrét-
nej metódy, ktorá je k dispozícii. Tu je dôležité zdôrazniť, že pri rôznych metódach 
sú rôzne posuny (cca niekoľko desiatok až stoviek metrov), ich výber je individuál-
ny a záleží od konkrétnych kartografických zobrazovacích systémov pri vrstvách na 
vstupe a výstupe.

Transformácia kartografického zobrazovacieho systému pre rastrové geografické infor-
mácie sa realizuje nástrojom Project Raster, ktorý sa nachádza v aplikácii  ArcToolBox, 
v časti Data Management Tools → Projection and Transformation → Raster → Project 
Raster. 

Zobrazené okno s názvom 1 . Project Raster ponúka identické funkcie a voľby na za-
dávanie vstupných a výstupných parametrov ako nástroj, určený pre vektorové dáta 
(Project).

Hlavný rozdiel je v spodnej časti dialógového okna, kde sú nasledovné voľby:2 . 

Resampling Technique (optional)2 .1 .  – výber algoritmu, ktorým sa interpolujú 
hodnoty obrázkových bodov – pixlov rastra. Algoritmus sa aplikuje len v prípa-
de zmeny tvaru, veľkosti, farebnej hĺbky atď. medzi vstupom a výstupom. K dis-
pozícii je niekoľko metód.

 • NEAREST – najrýchlejšia metóda, ktorá zachováva ostré hrany medzi pre-
chodmi, používa sa hlavne pre diskrétne dáta. Maximálna zmena hodnoty 
bunky bude do 50 % z pôvodných (vstupných) hodnôt.

 • BILINEAR – metóda, ktorá priraďuje nové hodnoty bunkám na základe vá-
ženého priemeru hodnôt vzdialených zo štyroch najbližších stredov buniek. 
Metóda je vhodná pre spojité dáta. 

 • CUBIC – časovo náročná metóda, ktorá priraďuje nové hodnoty bunkám na 
základe hodnôt vzdialených zo šestnástich najbližších stredov buniek. Táto 
metóda môže spôsobiť kompletnú zmenu hodnôt výstupných buniek oproti 
vstupným, čo môže byť v niektorých prípadoch neprípustné. Metóda sa po-
užíva pri spojitých dátach.
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 • MAJORITY – metóda, ktorá priraďuje nové hodnoty v rámci preddefino-
vaného filtra. Je určená pre diskrétne dáta, kde sú ostré hrany viac zaoblené 
v porovnaní s metódou NEAREST.

Output Cell Size (optional)2 .2 .  – definovanie veľkosti výstupnej bunky. Vynecha-
ním tejto voľby bude mať výstup rovnakú veľkosť bunky ako vstup.

Registration 2 .3 . Point (optional) – tzv. registračný bod, ktorým sa definuje presná 
poloha výstupných buniek prostredníctvom „X“ a „Y“ súradnice. Vynechaním 
voľby budú vstupná a výstupná veľkosť bunky zhodné.

5 .4 . Lišta GPS
Aplikácia ArcMap priamo podporuje on-line prácu s externými zariadeniami resp. so 

systémami GNSS. Na tento účel máme k dispozícií lištu s názvom GPS (obrázok 82), ktorú 
je možné spustiť v hlavnom menu položkou Customize → Toolbars → GPS. Lišta obsahuje 
niekoľko položiek a nástrojov:

Obrázok 82

1 .  GPS Connection Setup – nastavenie GNSS prijímača a referenčného telesa pre 
kartografický zobrazovací systém. ArcMap pracuje s GNSS systémom na úrovni 
geo grafického zobrazovacieho systému a bázy I/O technológie COM portov. GNSS 
systém musí byť k aplikácii ArcMap pripojený prostredníctvom COM portov. V prí-
pade pripojenia cez USB musíme zabezpečiť softvérovú emuláciu USB na COM. 
Geo grafický zobrazovací systém bude na 2D pracovnej ploche zobrazovať údaje 
v tzv. „roztiahnutom“ až „sploštenom“ vzhľade, avšak bez zmeny presnosti.

2 .  GPS Position – informačné okno (obrázok 83) s informáciami o geografickej po-
lohe, aktuálnej rýchlosti, nadmorskej výške, kvalitatívnych ukazovateľoch intenzity 
signálov atď.

Clear 3 . GPS Display – vymazanie všetkých hodnôt dialógového okna  GPS Posi-
tion.

4 .  Auto Pan – automatické posúvanie obsahu mapového okna s aktuálnou polo-
hou.

5 .  Destination Properties – symbologické nastavenie cieľového bodu.



57

Clear Destination6 .  – odstránenie aktu álneho cieľového bodu.

7 .  Log Setup – nastavenie formátu 
záznamu z navigácie, t. j. typ prvku resp. 
geometria, interval ukladania záznamu 
(časový alebo vzdialenostný) atď.

Display Options 8 . – nastavenie pracov-
ných jednotiek, farebnej symbológie, 
pri chytávania k zvolenej vrstve atď. 

9 .  Open Connection – spustenie navigá-
cie.

10 .  Stop Connection – ukončenie navigá-
cie.

11 .  Start Streaming To Log – spustenie procesu vytvárania záznamu z navigácie na 
základe nastavenia pochádzajúceho z položky  Log Setup.

12 .  Stop Streaming To Log – ukončenie procesu vytvárania záznamu.

13 .  Stamp Current Position To Log – uloženie aktuálnej polohy do preddefinované-
ho záznamu (  Log Setup) bez ohľadu na to, či je spustený proces vytvárania alebo 
nie. 

14 .  Zoom To GPS Position – centrovanie zobrazenia aktuálnej pozície.

15 .  Add Destination – vloženie cieľového bodu. 

Otázky:

Čo je to georeferencovanie?1. 

Aký nástroj sa používa na umiestňovanie geografických alebo 2. 
kartografických súradníc geografickej polohy do vrstvy geografických 
informácií?

Akú funkciu má nástroj 3. Project?

Akým nástrojom je realizovaná podpora on-line práce s externými 4. 
zariadeniami?

Obrázok 83
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6 . Geoprocesingové nástroje – ArcToolbox
Geoprocesing predstavuje proces spracovania geografických informácií pomocou 

spektra nástrojov určených na správu, transformáciu a priestorové analýzy geografických 
informácií. Nástrojmi vykonávame transformácie geometrických útvarov, geografickej po-
lohy, správu geodatabáz, analýzy vstupných úda-
jov do podoby výstupných údajov, ktoré mô žu 
mať analytický alebo syntetický charakter atď. 
Ide o autonómne nástroje, ktoré zväčša pracu-
jú na automatickej báze. Vzájomné používanie 
jednotlivých nástrojov a používateľské vstupy do 
algoritmov ponúkajú široké aplikačné mož nosti 
práce s geografickými informáciami. Vo vše-
obecnej úrovni sa pod geoprocesingom rozumie 
proces vytvárania nových vrstiev geografických 
informácií za pomoci existujúcich vrstiev.

 ArcToolbox je aplikácia, v ktorej je organi-
začne usporiadaných niekoľko stoviek geopro-
cesingových nástrojov podľa jednotlivých tém 
a odvetví ich použitia (obrázok 84).

V tejto kapitole si predstavíme nástroje ur-
čené na prácu s vektorovými dátovými model-
mi. Pôjde o najčastejšie používané nástroje geo-
metrických transformácií, priestorových analýz 
a dátovej správy. Ostatné nástroje sú podmiene-
né konkrétnym aplikačným použitím v danom 
odbore, napr. hydrológia alebo geomorfológia 
atď.

Nástroje aplikácie  ArcToolbox môžeme 
spustiť niekoľkými spôsobmi: 

priamo kliknutím na ikonku 1 .  ArcTool-
box, ktorá sa nachádza v štan dardnej lište 
aplikácie ArcMap, 

pomocou okna vyhľadávania (2 .  Search) 
a záložky Tools v bočnom paneli aplikácie 
ArcMap (obrázok 85). 

Priebeh akejkoľvek operácie geopro ce sin-
g ových nástrojov je zobrazený v pravej dolnej 
časti okna aplikácie ArcMap. Po vykonaní geo-
procesingovej operácie ArcMap informuje o jej 
priebehu (obrázok 86). 

Aplikácia  ModelBuilder, ktorá sa nachádza 
na štandardnej lište, umožňuje vytvárať reťazce, 
resp. modely na nadväzujúce používanie nás tro-
jov geoprocesingu. Do jedného modelu môžeme 
vzájomne previazať niekoľko nástrojov, ktoré 
medzi sebou pracujú. Takéto modely vytvárame 

Obrázok 84

Obrázok 85
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v prípade, ak chceme spracovať geografické infor-
mácie niekoľkými nástrojmi v určitej chronológii 
a periodicite.

6 .1 . Analysis Tools
Ide o najčastejšie používaný súbor nástrojov určených na priestorové operácie. Na zá-

klade vstupných analytických dát vytvárame výstupné geografické informácie, ktoré majú 
buď analytickú alebo syntetickú podobu. V prípade analytickej úrovne dochádza k úprave 
vstupných dát do podoby nových vrstiev. V prípade syntetickej úrovne vytvárame nový typ 
vrstiev, v ktorých sú obsiahnuté prieniky (databázo-
vé a geometrické) viacerých analytických vstupov.

1 . Clip (ArcToolbox → Analysis Tool → Ex-
tract) – nástroj je určený na extrahovanie 
prvkov zo vstupnej vrstvy (Input Features) 
na základe zadanej šablóny (Clip Features). 
Ide o nástroj, ktorým „vykrajujeme“ priestor 
(podľa šablónovej vrstvy) zo vstupnej vrstvy 
(obrázok 87). Šablónová vrstva slúži na vy-
medzenie priestoru, v ktorom prebehne 
operácia viazaná na nástroj Clip. Atribúto-
vá tabuľka bude obsahovať len atribúty zo 
vstupnej vrstvy (Input Features), nebude ob-
sahovať atribúty z tzv. šablónovej vrstvy (Clip 
Features).

2 . Split (ArcToolbox → Analysis Tool → Ex-
tract) – pomocou geometrického prieniku 
rozdeľujeme vstupnú vrstvu (Input Features) 
na niekoľko ďalších vrstiev (obrázok 88), kto-
ré budú uložené v osobitnom adresári alebo 
geodatabáze (Target Workspace). Rozdelenie 
vykonávame podľa geometrie prvkov zo za-
danej šablóny (Split Features) a vybraného 
textového atribútu (Split Field). 

3 . Erase (ArcToolbox → Analysis Tool → 
Overlay) – vzájomným prekrývaním dvoch 
vrstiev (obrázok 89) realizujeme výrez do 
vstupnej vrstvy (Input Features) pomocou 
geometrie prvkov zo zadanej vrstvy (Erase 
Features). Vrstvu, ktorou orezávame vstupnú 
vrstvu, môže tvoriť bod, línia alebo polygón, 
avšak obidve vrstvy musia byť v rovnakom 
priestorovom rozsahu.

Obrázok 86

Obrázok 87

Obrázok 88

Obrázok 89
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Identity4 .  (ArcToolbox → Analysis Tool → Overlay) – nástroj je určený na výpočet 
geometrického prieniku dvoch vrstiev (obrázok 90), kde vstupná vrstva (Input Fea-
tures) bude geometricky a databázovo „obohatená“ o parametre tzv. identifikačnej 
vrstvy (Identity Features). Identifikačná vrstva musí mať rovnaké geometrické roz-
hranie ako vstupná vrstva. 

5 . Intersect (ArcToolbox → Analysis Tool → Overlay) – nástroj je určený na výpočet 
geometrického prieniku (obrázok 91) minimálne dvoch vrstiev (Input Features). 
Vstupné vrstvy môžu byť rôzneho dátového 
formátu, to znamená, že môžu obsahovať 
prvky s bodovou, líniovou a polygónovou 
geometriou. Ak do výpočtu vstupujú rôzne 
typy dátových formátov, vo výstupnom dá-
tovom formáte bude tá geometria, ktorá má 
menší plošný záber. Napríklad ak jedna zo 
vstupných vrstiev obsahuje prvky s bodovou 
geometriou a druhá polygónové prvky, vý-
stupnou vrstvou bude bodová vrstva geogra-
fických informácií. 

Rozdiel medzi Identity a Intersect je v tom, 
že geometrický prienik pomocou nástroja In-
tersect nie je viazaný na zachovanie paramet-
rov vstupnej vrstvy (Input Features). 

6 . Symmetrical Difference (ArcToolbox → 
Analysis Tool → Overlay) – nástroj je urče-
ný na výpočet prieniku dvoch vrstiev, avšak 
v mieste ich prekrývania sa vytvorí prázdny 
priestor, to znamená, že v tomto priestore 
dôjde k odstráneniu prvkov (obrázok 92). 
Obidve vrstvy musia mať rovnaké geometric-
ké rozhranie. 

7 . Union (ArcToolbox → Analysis Tool → 
Overlay) – nástroj je určený na tvorbu geo-
metrického a databázového prieniku dvoch 
vrstiev (Input Features) s polygónovou geo-
metriou (obrázok 93). Ide o podobný nástroj 
ako Intersect, avšak vo výstupnej vrstve ostá-
vajú zachované aj plochy prvkov, ktoré sa 
neprekrývajú. V atribútovej tabuľke ostávajú 
záznamy prvkov s prienikom, ale aj bez neho. 
Pri nástroji Intersect sú vo výstupnej vrstve 
a atribútovej tabuľke zaznamenané len prvky 
vo vzájomnom prieniku.

Obrázok 91

Obrázok 92

Obrázok 93

Obrázok 94

Obrázok 90
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8 . Update (ArcToolbox → Analysis Tool → Overlay) – geometrickým prienikom 
dvoch polygónových vrstiev sa aktualizuje vstupná vrstva (Input Features) o para-
metre z tzv. aktualizačnej vrstvy (obrázok 94). Nástrojom vytvárame novú vrstvu, 
čím nedochádza k zmenám vo vstupnej vrstve. Nástroj ponúka funkciu s názvom 
Border, ktorá zachováva priebeh vonkajších hraníc tzv. aktualizačnej vrstvy (Update 
Features). V prípade nevyužitia tejto funkcie budú vonkajšie hranice odstránené, 
čiže dôjde k spojeniu vstupnej a aktualizačnej vrstvy.

9 . Buffer (ArcToolbox → Analysis Tool → Proximity) – nástroj je určený na vytváranie 
obalových zón prvkov (obrázok 95) nachádzajúcich sa v zadefinovanej vrstve (Input 
Features). K nástroju máme v ponuke niekoľko parametrov, ktorými si prispôsobu-
jeme priebeh operácie:

 • Distance [value or field] – definujeme zdroj na zadanie veľkosti obalovej zóny. 
Na výber máme dve možnosti, a to Linear unit (zadávame požadovanú hodnotu 
veľkosti obalovej zóny) alebo Field (vyberieme názov stĺpca z atribútovej tabuľky, 
kde sú uložené číselné hodnoty, podľa ktorých sa vytvorí obalová zóna). 

 • Side Type (optional) – definujeme smer vytvárania obalovej zóny. Voľba FULL 
vykoná obalovú zónu do obidvoch smerov od vonkajšieho priebehu hraníc da-
nej vrstvy. Voľba LEFT alebo RIGHT vykoná obalovú zónu do zvoleného ľavého 
alebo pravého smeru.

 • End Type (optional) – obalová zóna líniovej vstupnej vrstvy môže mať dva typy 
ukončenia, ROUND je možnosť pre zaoblený koniec a FLAT pre rovný koniec.

 • Dissolve Type (optional) – definujeme spôsob vzájomného zlučovania prvkov 
a ich atribútových záznamov. K dispozícii máme možnosť NONE, kde prvky 
a záznamy atribútovej tabuľky ostávajú v nezmenenom stave. Možnosťou ALL 
zlúčime prvky a ich záznamy do jednej plochy a jedného riadku. V časti okna 
s názvom Dissolve Field(s) (optional) vyberieme atribút (prípadne viacero atri-
bútov), podľa ktorého vykonáme vzájomné zlúčenie prvkov.

Obrázok 95
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Obrázok 96

10 . Multiple Ring Buffer (ArcToolbox → Analysis Tool → Proximity) – nástrojom vy-
tvárame po sebe niekoľko nasledujúcich obalových zón (obrázok 96) na základe za-
definovanej vzdialenosti (Distance).

11 . Near (ArcToolbox → Analysis Tool → Proximity) – k prvkom vo vstupnej vrstve 
(Input Features) vytvárame nové atribúty (vzdialenosť a uhol) s hodnotami o vzdia-
lenostiach k najbližším prvkom v cieľových vrstvách (Near Features). Výsledkom je 
upravená atribútová tabuľka vstupnej vrstvy (Input Features) o atribúty, napr. identi-
fikačné číslo (FID), najbližšia vzdialenosť (NEAR_DIST), najbližší bod X  (NEAR_X) 
a Y (NEAR_Y) súradníc, ako aj uhol (NEAR_ANGLE) k najbližšiemu bodu v cieľo-
vej vrstve. V ponuke nástroja máme možnosť voľby Search Radius (optional), kde 
definujeme maximálnu veľkosť priestoru (od prvkov vstupnej vrstvy), v ktorom sa 
budú vyhľadávať najbližšie prvky v cieľových vrstvách.

6 .2 . Data Management Tools
Ide o obsiahly súbor nástrojov určených na dátovú správu, resp. tvorbu a úpravu vrstiev 

geografických informácií v rozsahu súborových, geografických, geometrických a databázo-
vých operácií.

1 . Create Feature Class (ArcToolbox → Data Management Tools → Feature Class) – 
nástrojom vytvárame nové vrstvy geografických informácií, ktoré môžu byť uložené 
vo forme dátového súboru geodatabázy alebo ako samostatná .shp vrstva. Pri vytvá-
raní vrstvy špecifikujeme geometrické rozhranie, súradnicový systém atď. Vytváranie 
vrstiev geografických informácií môžeme realizovať taktiež prostredníctvom samostat-
nej aplikácie ArcCatalog alebo ArcCatalog v bočnom paneli aplikácie ArcMap.

2 . Create Random Points (ArcToolbox → Data Management Tools → Feature Class) 
– nástroj vo vymedzenom priestore generuje novú bodovú vrstvu s náhodným roz-
miestnením prvkov podľa definovaných parametrov:

Výber priestoru na náhodné umiestnenie, ktorý zadávame prostredníctvom  • Con-
structing Feature Class (optional) alebo Constraining Extent (optional). Priestor 
môže mať charakter líniového (líniová geometria) alebo plošného útvaru (poly-
gónová geometria). V prípade polygónu sa prvky umiestnia vo vnútri plochy. Pri 
línii dôjde k umiestneniu prvkov pozdĺž línie.

Počet bodov prostredníctvom  • Number of Points [value or field] (optional) podľa 
zadanej hodnoty (Long) alebo hodnôt z atribútovej tabuľky (Field), t. j. definova-
ný počet bodov pre každý prvok obsiahnutý vo vrstve.
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Minimálna vzdialenosť medzi umiestnenými bodmi prostredníctvom položky  •
Minimum Allowed Distance [value or field] (optional). Opätovne je možné za-
dať vstupnú hodnotu priamo (Linear unit) alebo formou hodnôt v atribútovej 
tabuľke (Field), t. j. pre každý prvok vo vrstve osobitne.

Zlučovanie bodov do jedného atribútového záznamu prostredníctvom  • Create 
Multipoint Output (optional).

3 . Add XY Coordinates (ArcToolbox → Data Management Tools → Features) – ku 
každému prvku v bodovej vrstve priradíme atribúty s hodnotami súradníc X a Y. 

4 . Check Geometry a Repair Geometry (ArcToolbox → Data Management Tools → 
Features) – nástroje sú určené na kontrolu a opravu geometrických chýb prvkov 
obsiahnutých vo vrstvách geografických informácií. Nástrojom Check Geometry 
vykonáme kontrolu geometrických chýb prvkov. Výsledkom je správa v tabuľkovej 
podobe s identifikačným číslom prvku a k nemu priradený konkrétny problém resp. 
chyba. Nástroj Repair Geometry vykoná identifikáciu geometrických chýb, ktoré ná-
sledne odstráni.

Geometrické transformácie5 .  (ArcToolbox → Data Management Tools → Features) – 
spektrum nástrojov určených na úpravu a transformáciu geometrických útvarov:

5 .1 . Dice – rozdelenie príliš veľkých prvkov na menšie prvky podľa maximálneho 
počtu uzlov.

5 .2 . Feature Envelope To Polygon – prvky budú ohraničené pravouhlým geometric-
kým útvarom (štvorec alebo obdĺžnik) rovnobežne s osou X a Y. 

5 .3 . Feature To Line – transformácia prvkov na líniové geometrické útvary. V prípa-
de dvoch a viacerých vstupných vrstiev (Input Features) sa bude klásť dôraz na 
ich vzájomné prieniky. 

5 .4 . Feature To Point – každý prvok vstupnej vrstvy (Input Features) nahradíme 
samostatným bodom, ktorý bude umiestnený v strede vstupného prvku, t. j. vy-
tvárame centroidy. Pri voľbe Inside (optional) budú body umiestnené vo vnú-
tornej ploche prvkov, ale mimo ich stredov. 

5 .5 . Feature To Polygon – transformácia prvkov vstupných vrstiev na polygónové 
geometrické útvary. V prípade dvoch a viacerých vstupných vrstiev (Input Fea-
tures) sa bude klásť dôraz na ich vzájomné prieniky. 

5 .6 . Feature Vertices To Points – transformácia uzlov v prvkoch vstupných vrstiev 
(Input Features) na bodové geometrické útvary. V ponuke Point Type (optio-
nal) máme niekoľko možností transferov:

ALL •  – transfer všetkých uzlov na body,

MID •  – transfer len stredového uzla na bod, 

START  • – transfer len začiatočného uzla,

END  • – transfer len koncového uzla,

BOTH_ENDS •  – transfer začiatočného a koncového uzla, 

DANGLE  • – transfer určený len pre líniový typ geometrie, kde bude obsiah-
nutý len začiatočný a koncový uzol. 
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6 . Minimum Bounding Geometry (ArcToolbox → Data Management Tools → Featu-
res) – na základe vstupných vrstiev (Input Features) vytvárame polygónovú vrstvu 
s ich minimálnym možným ohraničením resp. minimálnym počtom uzlov. V ponu-
ke Geometry Type (optional) máme niekoľko možností tvorby podľa:

RECTANGLE_BY_AREA •  – najmenšej plochy,

RECTANGLE_BY_WIDTH •  – najmenšej dĺžky/šírky,

CONVEX_HULL •  – najmenšej plochy, pri ktorej môže vzniknúť útvar bez pravo-
uhlých strán,

CIRCLE •  – najmenšieho kruhového útvaru,

ENVELOPE •  – najmenšej výmery štvorca alebo polygónu. 

V ponuke Group Option (optional) sa nachádzajú možnosti vzájomného zlučovania 
prvkov obsiahnutých v jednej vrstve:

NONE •  – bez vzájomného zlučovania do súvislej plochy, 

ALL •  – zlúčenie všetkých prvkov do jednej súvislej plochy,

LIST •  – zlučovanie prvkov podľa špecifikovaných hodnôt zadaných z atribútovej 
tabuľky. 

7 . Multipart To Singlepart (ArcToolbox → Data Management Tools → Features) – 
transfer viacerých prvkov, ktoré majú jeden záznam v atribútovej tabuľke (multi-
part) na úroveň, kde každý prvok má osobitný záznam, t. j. položku v atribútovej 
tabuľke.

8 . Points To Line (ArcToolbox → Data Management Tools → Features) – nástroj ur-
čený na tvorbu líniovej vrstvy podľa bodov vstupnej vrstvy (Input Features). V časti 
Line Field (optional) definujeme, ktoré atribúty budú vo výstupnej tabuľke. V časti 
Sort Field (optional) definujeme poradie spájania bodov do línie. Voľba Close Line 
(optional) umožňuje uzavrieť líniu, t. j. spojiť jej začiatok s koncom.

9 . Polygon To Line (ArcToolbox → Data Management Tools → Features) – nástrojom 
vykonáme transfer prvkov polygónovej geometrie (Input Features) na líniovú geo-
metriu s možnosťou voľby identifikácie vzájomných prienikov Identify and store 
polygon neighboring information (optional). Ak sa vstupné prvky vzájomne pre-
krývajú, ich prienik bude premietnutý do samostatných línií.

10 . Append (ArcToolbox → Data Management Tools → General) – prvky vybraných 
vrstiev (Input Datasets) pridáme k zvolenej vrstve prvkov (Target Dataset). Cieľovú 
vrstvu aktualizujeme o obsah vybranej vrstvy. 

11 . Merge (ArcToolbox → Data Management Tools → General) – spájanie niekoľkých 
vybraných (Input Datasets) vrstiev do novej vrstvy resp. súborovej sady v geodata-
báze (Output Dataset).

12 . Dissolve (ArcToolbox → Data Management Tools → Generalization) – nástroj 
určený na vzájomné zlučovanie prvkov, t. j. prostredníctvom databázových zázna-
mov vstupnej vrstvy (Input Features) a podľa definovaných atribútov v časti Dissol-
ve_Field(s) (optional). Bez výberu atribútu nástroj zlúči všetky prvky do jedného 
záznamu v atribútovej tabuľke. 
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13 . Eliminate (ArcToolbox → Data Management Tools → Generalization) – nástroj 
určený na odstránenie vybraných prvkov (napr. cez SQL výrazy) prostredníctvom 
ich zlúčenia so susednými prvkami, t. j. s ktorými majú spoločnú hranicu. Výber 
prvkov sa realizuje tzv. SQL výrazmi, napr. výmera menšia ako 0,5 ha. K dispozícii 
máme dva algoritmy zlučovania. Prvým je Eliminating polygon by border (optio-
nal), kde dochádza k zlučovaniu podľa prevládajúcej spoločnej hranice so susedný-
mi prvkami. Vybraný prvok bude zlúčený s tým susedným prvkom, s ktorým má 
dlhšiu spoločnú hranicu. Bez výberu voľby Eliminating polygon by border (optio-
nal) dôjde k zlučovaniu podľa prevládajúcej výmery. Ide o druhý algoritmus zlu-
čovania resp. odstraňovania prvkov. V časti Exclusion Layer (optional) môžeme 
vybrať rozsah prvkov (prostredníctvom SQL výrazov) alebo vrstvu, z ktorej nebudú 
vylúčené prvky pri aplikácii oboch algoritmov zlučovania.

14 . Eliminate Polygon Part (ArcToolbox → Data Management Tools → Generaliza-
tion) – nástroj určený na odstránenie menších prvkov alebo prázdnych miest vo 
vybraných prvkoch polygónovej vrstvy (Input Features). Odstraňovanie sa uskutoč-
ňuje na základe definovanej podmienky Condition (optional), ktorou je výmera ale-
bo percentuálny pomer. Výberom voľby Eliminate contained parts only (optional) 
budú odstránené len časti plôch nachádzajúce sa vo vnútornom priestore vstupných 
prvkov. Bez tejto voľby budú odstránené akékoľvek časti, nielen vo vnútornom 
priestore vstupných prvkov.

Otázky:

Čo je to geoprocesing?1. 

V akej zložke, resp. aplikácii, sú organizované geoprocesingové 2. 
nástroje?

Aký je rozdiel medzi nástrojom geoprocesingu 3. Intersect a Identity?

Ktorým nástrojom môžeme vytvárať tzv. obalové zóny?4. 

Ktorý nástroj sa používa na kontrolu a opravu geometrických chýb 5. 
obsiahnutých vo vrstvách geografických informácií?
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7 . Práca s atribútovými hodnotami
Aplikácia ArcMap ponúka množstvo rôznych nástrojov operácií s databázovým rozhra-

ním vrstiev geografických informácií. Medzi najčastejšie požadované operácie patrí vyhľa-
dávanie konkrétnych záznamov v atribútovej tabuľke a vytváranie vzájomných prepojení 
medzi atribútovými tabuľkami. 

Táto kapitola je zameraná na prácu s atribútovými hodnotami (databázou údajov), na 
základe ktorých je možné vyhľadať a zobraziť prvky nachádzajúce sa vo vrstvách geografic-
kých informácií. 

7 .1 . Select By Attributes
 Nástroj určený na výber prvkov z vrstvy geografických informácií podľa parametrov 
viazaných na záznamy v atribútovej tabuľke. Parametre definujeme pomocou tzv. SQL prí-
kazov, t. j. formou štruktúrovaného vyhľadávacieho jazyka (Structured Query Language – 
SQL) určeného na prácu (výber, vkladanie, úprava a mazanie) s databázami.

Nástroj spustíme v položke hlavného menu 1 . Selection →  Select By Attributes. 
Zobrazené dialógové okno umožňuje výber vrstvy (2 . Layer), ku ktorej budeme reali-
zovať výber (obrázok 97). 

Obrázok 97

V padajúcom menu 3 . Method máme k dispozícii niekoľko spôsobov výberu prvkov:

Create new selection  • – nový výber, v prípade existujúceho výberu dôjde k jeho 
zrušeniu;
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Add to current selection  • – výber bude pridaný k súčasnému výberu;

 • Remove from current selection – výber bude odobraný zo súčasného výberu;

Select from current selection  • – výber bude viazaný len k prvkom, vybraným v sú-
časnosti.

Kombináciou konkrétnych tlačidiel (operátori) a hodnôt, ktoré sú uložené pod da-4 . 
ným atribútom, definujeme SQL výraz. Na zobrazenie záznamov vybraného atribútu 
využijeme tlačidlo Get Unique Values. V prípade konkrétnej hodnoty využijeme časť 
okna s názvom Go To.

Sériou príkazov jazyka SQL formulujeme kritériá vyhľadávania a následného zo-5 . 
brazovania záznamov z atribútovej tabuľky. Každý SQL príkaz musí byť sformulo-
vaný do reťazca, ktorý obsahuje <názov stĺpca atribútovej tabuľky>, <operátor>, 
<požadovanú hodnotu>. Jednotlivé reťazce je možné navzájom zlučovať prostred-
níctvom spájacích operátorov <názov stĺpca atribútovej tabuľky>, <operátor>, 
<požadovaná hodnota>, <Connector>, <názov stĺpca atribútovej tabuľky>, <ope-
rátor>, <požadovaná hodnota>. Názov stĺpca atribútovej tabuľky môže mať rôzny 
tvar zápisu:

v prípade vyhľadávania záznamov zo .shp súborov, dBASE tabuliek bude názov  •
stĺpca v úvodzovkách „Nazov“;

v prípade vyhľadávania záznamov v personálnej alebo súborovej geodatabáze  •
bude názov stĺpca v hranatých zátvorkách [Nazov];

v prípade vyhľadávania záznamov v ArcSDE geodatabázach bude názov stĺpca  •
bez ďalších znakov Nazov.

V spodnej časti dialógového okna máme k dispozícii tlačidlá na vymazanie reťazca 
(Clear), jeho kontrolu, či je správne zadaný (Verify), používateľský návod (Help), 
načítanie uložených reťazcov (Load) a uloženie nami zadaného reťazca (Save).

Vyhľadávanie textových záznamov5 .1 . 

„Nazov“ = ‚CHKO Biele Karpaty‘ •

Pomocou operátora = bude v atribúte „Nazov“ vyhľadaný záznam s presnou 
hodnotou ‚CHKO Biele Karpaty‘. 

„Nazov“ <= ‚CHKO K‘ •

Operátora = je možné upraviť o smer výberu v rámci abecedného radenia znakov. 
Takto upravený operátor vyberie všetky CHKO, ktoré majú začiatočné písmeno 
od A po K. Bez použitia operátora = by došlo len k výberu všetkých CHKO od 
A po J. Operátor = definuje požadovaný výber aj vrátane hodnoty, pre ktorú je 
špecifikovaný smer. 

„Nazov“ LIKE ‚CHKO V%‘ •

Operátorom LIKE budú v atribúte „Nazov“ vyhľadané všetky záznamy s reťaz-
com, ktoré obsahujú minimálne hodnoty CHKO V, t. j. CHKO Východné Kar-
paty a CHKO Vihorlat. 

Operátorom LIKE vytvárame tzv. čiastočné „presné“ vyhľadávacie reťazce, t. j. 
do požadovanej hodnoty môžeme vstupovať operátorom:
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„%“  • – vyhľadávanie akejkoľvek skupiny znakov. V prípade personálnej geo-
databázy využijeme operátor *.

„_“ •  – vyhľadávanie akéhokoľvek jedného znaku. V prípade personálnej geo-
databázy využijeme operátor ?.

„Nazov“ IS NOT NULL •

Porovnávacím operátorom IS NOT budú v atribúte „Nazov“ vyhľadané záznamy 
bez prázdnych hodnôt. V prípade operátora IS by boli vyhľadané len záznamy 
s obsahom prázdnych hodnôt.

 Vyhľadávanie číselných záznamov5 .2 . 

„Vymera“ >= 300 •

Porovnávacím operátorom >= budú v atribúte „Vymera“ vyhľadané záznamy, 
ktoré majú výmeru 300 ha a viac.

„Vymera“ >= 300 * 100 •

Predchádzajúci výraz je možné doplniť o matematický operátor *, +, -, alebo /. 
V takomto prípade vyhľadáme záznamy, ktoré majú výmeru 30 000 ha a viac.

„Populacia“ / „Vymera“ <= 20 •

Vzájomnou atribútovou kombináciou a zvolenými matematickými operátormi 
môžeme v záznamoch vyhľadávať určité vzťahy medzi prvkami. V našom prí-
pade vyhľadávame okres, v ktorom je hustota populácie 20 a menej obyvateľov 
na 1 km2.

 Vyhľadávanie pomocou logických operátorov5 .3 . 

„Vymera“ > 50000 AND „Nazov“ LIKE ‚CHKO%‘ •

Logickým operátorom AND budú v požadovaných atribútoch vyhľadané všetky 
CHKO s výmerou väčšou ako je 50 000 ha.

„Vymera“ > 50000 OR „Nazov“ LIKE ‚CHKO X%‘ •

Logickým operátorom OR budú vyhľadané záznamy aspoň z jedného požadova-
ného atribútu. V našom prípade vyhľadáme všetky chránené územia s výmerou 
nad 50 000 ha, keďže v skutočnosti ani jedno CHKO nezačína prvým písmenom 
X. 

NOT „Nazov“ = ‚CHKO Dunajské luhy‘ •

Logickým operátorom NOT budú vyhľadané všetky záznamy okrem definovanej 
hodnoty. V našom prípade vyhľadáme všetky CHKO Slovenska okrem CHKO 
Dunajské luhy.

„Typ“ = ‚NP‘ AND NOT „Vymera“ >= 40000 •

Vzájomnou atribútovou kombináciou a zvolenými logickými operátormi mô-
žeme v záznamoch vyhľadávať určité vzťahy medzi prvkami. V našom prípade 
vyhľadávame všetky národné parky, ktoré nemajú výmeru 40 000 ha a viac.

SQL jazyk ponúka širokú paletu funkcií, podľa ktorých je možné vytvárať vyhľadávacie 
výrazy. V tejto časti sú rozpísané len tie najzákladnejšie. Okrem nich existuje celý rad mate-
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matických operátorov, logických a dátumových funkcií atď. Použiteľnosť akéhokoľvek výra-
zu je vždy podmienená daným účelom a štruktúrou databázy, z ktorej požadované hodnoty 
vyhľadávame.

7 .2 . Select By Location
Nástroj určený na výber prvkov z vrstvy geografických informácií podľa relatívnej polo-

hy k prvkom obsiahnutým v ďalšej vrstve alebo v ďalších vrstvách geografických informácií. 
Výber sa uskutočňuje na základe relatívnej geografickej polohy minimálne medzi dvoma 
vrstvami. 

Relatívnou geografickou polohou rozumieme takú polohu, ktorá nie je meraná od nul-
tého poludníka a rovníka, ale od ľubovoľného objektu na zemskom povrchu, napr. od stredu 
nákupného centra, stredu štadióna, stredu mesta, od vrcholu pohoria atď. Absolútna geo-
grafická poloha, na rozdiel od relatívnej geografickej polohy, vyjadruje polohu objektu na 
zemskom povrchu za pomoci geografickej siete (poludníky a rovnobežky).

Obrázok 98

Nástroj spustíme z položky hlavného menu 1 . Selection →  Select By Location. 

V padajúcom menu 2 . Method máme k dispozícii niekoľko spôsobov výberu prvkov 
(obrázok 98):

Select features from  • – identifikácia cieľových vrstiev, z ktorých sa bude realizovať 
výber vo vzťahu k zdrojovej vrstve, 
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Add to the currently selected features in  • – výber bude pridaný k súčasnému vý-
beru,

 • Remove from the currently selected features in – výber bude odobraný zo súčas-
ného výberu,

Select from the currently selected features in •  – výber bude viazaný len k súčasne 
vybraným prvkom.

V časti okna s názvom 3 . Target layer(s) identifikujeme cieľovú vrstvu alebo vrstvy, 
z ktorých budú vyberané prvky vo vzťahu k zdrojovej vrstve.

Špecifikáciu zdrojovej vrstvy realizujeme v padajúcom menu 4 . Source layer. Zdrojová 
vrstva predstavuje určitý priestor, podľa ktorého sa budú vyberať prvky z cieľovej 
vrstvy alebo vrstiev. Prvky sa budú označovať podľa ich relatívnej polohy k prvkom 
tejto vrstvy.

Voľba konkrétnej priestorovej metódy výberu prvkov (z cieľovej vrstvy alebo vrstiev) 5 . 
sa nachádza v časti okna s názvom Spatial selection method for target layer featu-
re(s). 

Pre niektoré metódy je potrebné zadať tzv. vyhľadávací rádius (6 . Apply a search dis-
tance), ktorým definujeme maximálnu veľkosť priestoru na aplikáciu zvolenej metó-
dy. Pri niektorých metódach je táto možnosť voliteľná alebo nie je k dispozícii. 

7 .3 . Práca s vybranými prvkami
Aplikácia ArcMap ponúka rôzne možnosti práce s vybranými prvkami. Ide o súbor ná-

strojov, ktorými môžeme vybrané prvky zobraziť a spravovať podľa našich požiadaviek.

V hlavnom menu aplikácie ArcMap sa nachádza položka 1 . Selection s nasledovným 
rozsahom nástrojov (obrázok 99): 

 •  Zoom To Selected Features – zobrazenie vybraných záznamov resp. prvkov 
v mapovom okne,

 •  Pan To Selected Features – zobrazenie vybraných záznamov resp. prvkov 
v strede mapového okna,

Obrázok 99
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 •  Statistics – zobrazenie štatistických ukazovateľov podľa zvoleného atribútu,

 •  Clear Selected Features – hromadné zrušenie výberu prvkov,

Interactive Selection Method  • – metóda výberu prvkov, ktorá je viazaná k nástro-
ju  Select Features z lišty základných nástrojov,

Selection Options  • – možnosti nastavenia farby výberu, tolerancie počtu pixlov 
pri výbere, rôznych typov upozornení atď. 

Pri práci s vrstvou, v ktorej sme uskutočnili výber prvkov, je možné prostredníctvom 2 . 
kontextového menu a položky Selection využiť nasledovný rozsah nástrojov (obrá-
zok 100):

 •  Switch Selection – inverzná zmena výberu záznamov;

 •  Select All – výber všetkých prvkov (záznamov) k danej vrstve;

Make This The Only Selectable  • Layer – umožňuje interaktívny výber prvkov  
(  Select Features) len tejto vrstvy. Prvky z ostatných vrstiev nebude možné 
vyberať;

Copy Records for Selected Features  • – kopírovanie vybraných záznamov, t. j. len 
atribútové rozhranie, nie geometrické;

Create  • Layer From Selected Features – vytvorenie novej vrstvy z vybraných prv-
kov. Nová vrstva bude mať len formu dočasného umiestnenia v okne obsahu, 
preto je potrebné túto vrstvu uložiť do jej fyzickej podoby, napr. ako súbor .shp;

 •  Open Table Showing Selected Features – otvorenie atribútovej tabuľky len 
s vybranými prvkami.

Obrázok 100

Vybrané prvky a k nim viazané atribútové záznamy vstupujú samostatne do spraco-3 . 
vania ďalšími nástrojmi. Ide hlavne o nástroje exportu a geoprocesingu, napr. vzá-
jomné zlučovanie prvkov k danej vrstve (ArcToolbox → Data Management Tools → 
Generalization → Dissolve) sa uskutoční len k vybraným prvkom.
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7 .4 . Vzťahy medzi databázovým rozhraním 
Aplikácia ArcMap umožňuje vytvárať rôzne typy vzájomných prepojení medzi atribúto-

vými tabuľkami alebo databázami, ktoré pochádzajú z rôznych externých zdrojov. Vytvára-
nie vzťahov medzi databázami a atribútovými tabuľkami sa uskutočňuje nástrojmi Joins and 
Relates. Vytváranie prepojení medzi dátami v geodatabázach je osobitnou časťou, ktorej sa 
nebudeme venovať. Akékoľvek vytváranie vzťahov sa uskutočňuje pomocou tzv. relačného 
kľúča. Ide o jedinečný záznamový identifikátor (stĺpec s atribútovými hodnotami) nachá-
dzajúci sa v databázach, ktoré chceme prepojiť. Relačné kľúče majú identické záznamy. Na 
základe parity relačných kľúčov dochádza k ich spájaniu.

Nástroj Join dovoľuje pridávať dodatočné údaje k atribútom v tabuľke zvolenej vrstvy. 
Ide o rozšírenie atribútovej tabuľky o nové atribúty a záznamy pridávanej databázy.

Nástroj spustíme z kontextového menu k vrstve, ku ktorej chceme pridať údaje z inej 1 . 
atribútovej tabuľky alebo externej databázy. Z kontextového menu vyberieme polož-
ku Joins and Relates → Join.

Zobrazené dialógové okno (2 . obrázok 101) v časti What do you want to join to this 
layer? ponúka dve metódy spájania. Prvou je Join attribute from a table, t. j. prepoje-
nie medzi vrstvou, ku ktorej sme spustili nástroj Join, a zvolenou databázou. Druhou 
metódou je Join data from another layer based on spatial location, t. j. na základe 
zvolených pravidiel priestorového umiestnenia vytvoríme spojenie medzi nami zvo-
lenou vrstvou, ku ktorej sme spustili nástroj, a cieľovou vrstvou.

Obrázok 101

Po výbere možnosti3 .  Join attribute from a table je potrebné zvoliť relačný kľúč (1. 
Choose the field in this layer that the join will be based on:) zo zdrojovej vrstvy (ku 
ktorej sme spustili nástroj Join). Ide o atribút, ktorý bude totožný s atribútom cieľovej 
vrstvy.
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V časti okna s názvom4 .  2. Choose the table to join to this layer, or load the table from 
disk: špecifikujeme cieľovú vrstvu, ktorá bude pripojená k zdrojovej vrstve.

Z cieľovej vrstvy je potrebné vybrať relačný kľúč (5 . 3. Choose the field in the table to 
base the join on:), ktorý bude totožný s atribútom zdrojovej vrstvy. Ide o identifiká-
tor, podľa ktorého sa uskutoční prepojenie medzi atribútovou tabuľkou a zvolenou 
databázou.

Vzájomné prepojenie medzi zdrojovou atribútovou tabuľkou a cieľovou databázou je 6 . 
možné vykonať dvoma spôsobmi:

Keep all records •  – všetky záznamy z cieľovej databázy budú zobrazené, resp. pri-
pojené, k zdrojovej atribútovej tabuľke bez ohľadu na to, či sa jednotlivé relačné 
kľúče vzájomne zhodujú. Ak sa relačné kľúče nezhodujú, jednotlivé atribúty budú 
mať nulové hodnoty.

Keep only matching records  • – vzájomné prepojenie sa uskutoční len v zázna-
moch, v ktorých sa zhodujú relačné kľúče. Ostatné záznamy, kde sa zadané relač-
né kľúče nebudú zhodovať, budú odstránené.

Opísaným spôsobom sa atribúty a záznamy cieľovej databázy zobrazujú v zdrojo-7 . 
vej vrstve, t. j. zdrojovú vrstvu sme rozšírili o parametre cieľovej databázy. Uvedené 
prepojenie je možné odstrániť v kontextovom menu k danej vrstve a položke Joins 
and Relates → Remove Join(s), kde môžeme vybrať možnosť odstránenia všetkých 
prepojení (Remove All Joins) alebo konkrétneho podľa názvu cieľovej databázy.

Vytvorené prepojenie je len dočasné, t. j. k danej vrstve neboli fyzicky vložené atri-8 . 
búty a záznamy z cieľovej vrstvy. Prepojenie je vytvorené len pre mapový dokument, 
preto je potrebné danú vrstvu opätovne uložiť pomocou kontextového menu Data 
→ Export Data.

Nástrojom Relate definujeme vzťah medzi dvoma zvolenými databázami. Prostredníc-
tvom nástroja nedochádza k fyzickému pripojeniu cieľových parametrov k zdrojovej atri-
bútovej tabuľke tak, ako je to pri nástroji Join. Avšak pri práci so zdrojovou atribútovou 
tabuľkou získavame následne prístup aj k záznamom z cieľovej databázy. 

Nástroj spustíme v kontextovom menu k vrstve, ku ktorej chceme pripojiť cieľovú 1 . 
databázu. Z kontextového menu vyberieme položku Joins and Relates → Relate.

Zobrazené dialógové okno v časti 2 . 1. Choose the field in this layer that the relate will 
be based on: umožňuje výber atribútu (relačný kľúč) k zdrojovej vrstve (ku ktorej 
sme spustili nástroj Relate). Ide o atribút, ktorý bude totožný s atribútom cieľovej 
vrstvy.

V časti okna s názvom3 .  2. Choose the table to join to this layer, or load the table 
from disk: špecifikujeme cieľovú vrstvu, ku ktorej bude vytvorený relačný databázo-
vý vzťah.

Z cieľovej vrstvy je potrebné vybrať relačný kľúč (4 . 3. Choose the field in the related 
table or layer to base the relate on:), resp. atribút, ktorý bude totožný s atribútom 
zdrojovej vrstvy. 

Posledná časť okna ponúka možnosť vložiť názov relačného vzťahu medzi zdrojovú 5 . 
a cieľovú vrstvu (4. Choose a name for the relate:). Tento názov sa bude zobrazovať 
pri práci s atribútovou tabuľkou zdrojovej vrstvy.
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Vytvorený relačný vzťah je možné odstrániť prostredníctvom kontextového menu 6 . 
k danej vrstve a položky Joins and Relates → Remove Relate(s):, kde môžeme vybrať 
možnosť odstránenia všetkých prepojení (Remove All Relates) alebo konkrétneho, 
podľa zadaného názvu relačného vzťahu.

 Vytváranie prepojení medzi databázami sa uskutočňuje podľa niekoľkých základných 
typov vzťahov (relationship). Ide o vzťahy viazané k relačnému kľúču, t. j. k rovnakým atri-
bútom nachádzajúcim sa v zdrojových a cieľových databázach. Rozoznávame nasledovné 3 
vzťahy pri vzájomnom spájaní databáz:

One to One (1:1)1 .  – jeden záznam zo zdrojovej tabuľky je pripojený k rovnakému 
záznamu v cieľovej tabuľke. Zdrojový a cieľový záznam sú zároveň relačným kľúčom, 
t. j. obsahujú unikátne hodnoty, ktoré sa neopakujú, napr. rodné číslo občana. 

One to Many (1:N) 2 . – k jednému záznamu zo zdrojovej tabuľky je priradených nie-
koľko záznamov z cieľovej tabuľky. Zdrojová tabuľka má relačný kľúč, napr. osobné 
číslo zamestnanca. V cieľovej tabuľke bude mať číslo zamestnanca niekoľko zázna-
mov (relačný kľúč). Ku každému záznamu bude napr. niekoľko odberateľov, o kto-
rých sa tento jeden príslušný zamestnanec stará. V prípade obráteného vzťahu hovo-
ríme o vzájomnom spájaní Many to One (N:1). 

Many to Many (M:N) 3 . – k viacerým záznamom je priradených viacero záznamov 
z cieľovej tabuľky, napr. zamestnanec s osobným číslom môže byť zamestnaný vo 
viacerých firmách a zároveň má viacero rôznych záznamov v každej firme. Na tento 
účel sa vytvára pomocná tabuľka. V tomto prípade sa vzťah uskutočňuje relačným 
kľúčom, ktorým je rodné číslo zamestnanca a identifikačné číslo firmy. Vo výslednej 
tabuľke bude niekoľko záznamov s rodným číslom zamestnanca a identifikačným 
číslom firmy. 

Otázky:

V akom vzťahu sa používajú tzv. príkazy jazyka SQL?1. 

Akú funkciu má nástroj 2. Select By Attributes?

Aká je základná formulácia SQL reťazca?3. 

Akú funkciu má nástroj 4. Select By Location?

Ktoré nástroje sa používajú na vytváranie vzájomných prepojení medzi 5. 
atribútovými tabuľkami?
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8 . Mapová zostava
Aplikácia ArcMap umožňuje efektívne a rýchle vytváranie mapových zostáv (mapových 

výstupov). Mapové zostavy vytvárame v pracovnom prostredí resp. v zobrazení Layout View. 
Pri vytváraní mapovej zostavy ide o tzv. sadzbu vrstiev geografických informácií do presne 
zadefinovanej veľkosti mapového listu (napr. A4, A3 atď.) a v zodpovedajúcej mierke.

V tejto kapitole sa oboznámime so základnými nástrojmi, ktoré sa používajú na vytvá-
ranie mapových zostáv. Kapitola svojím obsahovým zameraním smeruje do oblasti karto-
grafie, ktorá sa zaoberá zostavovaním mapových kompozícií s polohami objektov a javov 
nachádzajúcich sa na zemskom povrchu a jeho blízkom okolí.

8 .1 . Základné nastavenie mapovej zostavy
Akákoľvek práca s mapovou zostavou je podmienená správnym nastavením kartografické ho 

zobrazovacieho systému využitím rôznych pomocných nástrojov, formátom papiera a tlače.

Nastavenie formátu papiera, resp. mapového listu, sa uskutočňuje v položke hlavného 1 . 
menu File →  Page and Print Setup alebo v kontextovom menu, viažucom sa k pracov-
nej ploche Layout View, t. j. mimo plochy papiera. V zobrazenom dialógovom okne Page 
and Print Setup existujú dve možnosti nastavenia veľkosti mapového listu (obrázok 102): 

 • Paper – ponúka len zoznam formátov nainštalovaných tlačiarní, 

 • Map Page Size – ponúka rozšírený zoznam formátov bez previazania na nain-
štalované tlačiarne. Po odškrtnutí možnosti Use Printer Paper Settings sa môžu 
nastaviť požadované rozmery. Zároveň sa však stratia tlačové okraje (max. možný 
potlačiteľný priestor) mapovej zostavy. Budú viditeľné len okraje papiera a dáto-
vého rámu – dátových rámov. 

Pre obidve ponuky je možné nastaviť orientáciu papiera (Portrait – na výšku 
a Landscape – na šírku).

Obrázok 102
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Kontextové menu pracovnej plochy 2 . Layout View (mimo plochy papiera) ponúka 
niekoľko pomocných nástrojov, ktoré uľahčujú prácu s mapovou zostavou:

 • Rulers – obsahuje položku  Rulers, ktorou zobrazíme alebo vypneme po stra-
nách mapového okna umiestnené pravítka. V rámci položky môžeme využiť voľ-
bu Snap to Rulers, ktorou prichytávame objekty mapového okna k pravítkam.

 • Guides – obsahuje ďalšie dve položky, a to  Guides, ktorou zobrazíme alebo 
vypneme vodiace línie. Snap to Guides slúži na prichytávanie objektov mapové-
ho okna k vhodne umiestneným vodiacim líniám. Ide o horizontálne a vertikál-
ne čiary, ktoré majú len pomocný charakter a výrazne 
uľahčujú manipuláciu s objektmi pri ich premiestňovaní. 
Vo výstupnej forme mapovej zostavy (export alebo tlač) 
sa nebudú nachádzať. Jednotlivé línie zobrazíme tak, že 
ľavým tlačidlom myšky klikneme na ktorékoľvek miesto 
na pravítkach alebo zobrazíme kontextové menu (obrá-
zok 103), z ktorého vyberieme Set Guide. Odstránenie 
vodiacej línie vykonáme jej presunutím mimo rozsahu 
stupnice pravítka alebo prostredníctvom kontextového 
menu k danej línii, kde vyberieme Clear Guide. Odstrá-
nenie všetkých vodiacich línií vykonáme položkou Clear 
All Guides.

 • Grid – obsahuje položku  Grid a Snap to Grid. Prvou položkou zobrazíme ale-
bo vypneme tzv. sieť bodov (pravouhlá matica bodov a nami definovaná hustota 
v oboch smeroch). Druhá umožňuje prichytávať objekty mapového dokumentu 
k týmto jednotlivým bodom. Zobrazená sieť bodov sa nestáva súčasťou výstupnej 
formy mapovej zostavy, t. j. nebude sa nachádzať v tlačenom alebo exportovanom 
súbore.

 • Margins – obsahuje položky  Margins a Snap to Margins, ktoré slúžia na zo-
brazenie a vypnutie tlačových okrajov a prichytávanie objektov mapového doku-
mentu k tlačovým okrajom.

ArcMap Options •  – obsahuje súbor nastavení jednotlivých pomocných nástrojov, 
napr. formy zobrazenia pomocných nástrojov, hustotu gridovej siete, jednotky 
zobrazenia a rozsah stupnice na pravítkach, toleranciu prichytávania atď. K dia-
lógovému oknu s týmito nastaveniami sa môžeme dostať položkou Options kon-
textového menu.

Nastavenie dátového rámu (3 . Data Frame Properties) ponúka niekoľko možností pri-
spôsobenia pracovného prostredia. Dátový rám v tomto prípade predstavuje mapové 
pole, t. j. plochu vlastnej mapy bez plôch formálnych mapových prvkov (napr. názov, 
mierka, vysvetlivky atď.). V prípade viacerých dátových rámov v jednej mapovej zos-
tave budú jednotlivé nastavenia aplikované individuálne, tzn. pre každý dátový rám 
osobitne.

Frame  • – záložka (obrázok 104), pomocou ktorej prispôsobujeme orámovanie dá-
tového rámu, jeho farebnú výplň a tieňovanie. 

Grids  • – záložka (obrázok 105), v ktorej nastavujeme parametre geografickej sie-
te, t. j. sústavu pomocných orientačných čiar (poludníkov a rovnobežiek alebo 

Obrázok 103
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celočíselných násobkov súradníc použitého kartografického súradného systému) 
v mapovom poli (dátovom ráme), spájajúcich miesta s rovnakými geografickými 
súradnicami (napr. geografická šírka a dĺžka). Ide o súbor po sebe nasledujúcich 
dialógových okien a záložiek s rozsiahlou ponukou nastavení zobrazenia geogra-
fickej alebo kartografickej siete. 

Size and Position  • – záložka (obrázok 106), v ktorej definujeme veľkosť dátového 
rámu a jeho umiestnenie na osi X a Y (umiestnenie voči nastaveniam pravítka na 
okraji mapovej zostavy). 

Obrázok 106

Obrázok 104 Obrázok 105
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8 .2 . Formálne mapové prvky (komponenty)
Základným mapovým komponentom je jeden alebo viac dátových rámov (mapové pole), 

v ktorom alebo v ktorých sú organizované vrstvy so svojím obsahom a symbologickou inter-
pretáciou mapových znakov (obrázok 107). Medzi ďalšie formálne mapové prvky môžeme 
zaradiť názov mapy, legendu, mierku, severku a doplnkové grafické a textové symboly, napr. 
tiráž atď. V prípade využitia viacerých dátových rámov môžeme vytvárať rôzne tzv. mapové 
kompozície, kde jedna mapa môže mať podrobné zobrazenie obsahu (kataster obce) a druhá 
len orientačný obsah, t. j. menej podrobný, generalizovaný obsah (vyznačenie katastra obce 
vo vzťahu k štátnym hraniciam Slovenska). 

Obrázok 107

Mapa (mapová zostava, kompozícia), predstavuje zjednodušené zobrazenie Zeme, kozmu, 
kozmických telies a ich častí do roviny, prípadne na iný geometrický útvar, napr. glóbus. Mapa 
graficky znázorňuje objekty a javy nachádzajúce sa v určitom priestore. Vyhotovuje sa pomo-
cou tzv. kartografických zobrazení a definovaného pomeru zmenšenia objektov na mape voči 
skutočnosti, ktorému hovoríme mierka mapy. Slúži ako navigačná pomôcka, ktorá vyjadruje 
vzťahy medzi objektmi v priestore, ako sú napr. poloha, veľkosť, vzdialenosť, uhol atď. Každá 
mapa sa skladá z určitých prvkov – komponentov, ktoré majú svoj význam. Čítanie mapy je 
schopnosť pochopiť obsah mapy na základe vnímania mapových znakov s ich významom, 
polohou a súvisom s okolím. Preto je veľmi dôležité vyhotoviť takú mapovú zostavu, ktorá sa 
stane príjemne a jasne čitateľným dielom. Na dosiahnutie uvedených princípov máme k dispo-
zícii (položka hlavného menu s názvom Insert) nasledovné mapové komponenty: 

1 . Dynamic Text – umiestnenie textu s dynamickým obsahom, t. j. text, ktorý je pre-
viazaný so súčasnými vlastnosťami mapového dokumentu, dátového rámu a zostavy 
vytvorenej v lište nástrojov Data Driven Pages. Dynamický text pracuje na základe 
značiek podobných ako v jazyku HTML. 

Title •  – názov špecifikovaný v  Map Document Properties. Ak názov nie je špe-
cifikovaný, priradí sa súborový názov dokumentu (.mxd);
Current Date •  – aktuálny dátum podľa nastavenia operačného systému;
Current Time •  – aktuálny čas podľa nastavenia operačného systému;
User Name •  – používateľské meno podľa aktuálne prihláseného používateľa;
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Author •  – autor dokumentu, ktorý je špecifikovaný v  Map Document Properties;
Date Saved •  – dátum a čas uloženia dokumentu, ktorý je priradený k súborovým 
vlastnostiam (.mxd);
Document Name •  – súborový názov (.mxd) mapového dokumentu;
Document Path •  – plný názov adresárovej cesty, kde je uložený mapový doku-
ment;
Service  • Layer Credits – autorské informácie k použitým vrstvám z pracovného 
prostredia na báze ArcGIS for Server;

 • Coordinate System – zobrazovací kartografický systém priradený k dátovému 
rámu;

 • Data Frame Name – názov dátového rámu;
Reference Scale •  – referenčná mierka daného dátového rámu;

 • Data Frame Time – časový aspekt špecifikovaný k jednotlivým vrstvám;
Data Driven Page Name •  – názov strany v zostave Data Driven Page;
Data Driven Page Number •  – číslo strany v zostave Data Driven Page;
Data Driven Page with Count •  – číslo strany s číslom všetkých dostupných strán 
v zostave Data Driven Page;
Data Driven Page Display Expression •  – parametre z dialógového okna Layer 
Properties;
Data Driven Page Attribute •  – vybraný atribút vo vzťahu k indexovej vrstve. 

2 .  Legend – vysvetlivky (legenda) poskytujú „kľúč“ k pochopeniu použitých mapo-
vých znakov. Pri rozsiahlych mapových dielach bývajú vysvetlivky ako samostat-
ná knižná publikácia, napr. topografické, geomorfologické alebo geologické mapy. 
Vkladanie a nastavenie parametrov zobrazenia položiek vysvetliviek realizujeme po-
mocou samostatného sprievodcu s názvom Legend Wizard. Sprievodca ponúka nie-
koľko za sebou idúcich dialógových okien, v ktorých môžeme upraviť názov legendy, 
typ písma, rámik pozadia legendy, veľkosť a tvar mapových znakov a rozmiestnenie 
položiek (obrázok 108). 

Obrázok 108
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3 .  North Arrow – severka (orientačná šípka) graficky vyjadruje orientáciu mapy 
k svetovým stranám, najčastejšie k severu. V ponuke je galéria rôznych typov šípok, 
ktoré môžeme tlačidlom Properties upraviť podľa našich požiadaviek. 

4 .  Scale Bar a  Scale Text – mierka mapy definuje pomer zmenšenia grafických 
rozmerov objektu na mape voči skutočnosti. Čitateľovi pomáha vytvárať predsta-
vu o podrobnosti mapy. Číselná mierka udáva číselné zmenšenie objektov (ale aj 
dĺžok) na mape v tvare 1 : M, kde M je mierkové číslo. Napr. 1 cm na mape v mierke 
1 : 50 000 je v teréne 50 000 cm (= 500 m = 0,5 km). V mierke 1 : 200 000 predstavuje 
1 cm v mape v teréne 200 000 cm (= 2 000 m = 2 km). Grafická mierka vyjadruje 
mieru zmenšenej skutočnosti pomocou delenej úsečky, ktorá má svoje dĺžkové hod-
noty. V obidvoch položkách sú k dispozícii preddefinované štýly zobrazenia mierky. 
Každý štýl môžeme dodatočne upraviť podľa našich požiadaviek, t. j. zmeniť farbu, 
typ a veľkosť písma, hrúbku čiar atď.

5 .  Insert Picture – vložený obrázok v bežne podporovanom formáte.
6 .  Insert Object – vložené objekty, ktoré vytvoríme, alebo boli vytvorené, v pod po-

rovaných aplikáciách, napr. MS Office.
Pridané mapové komponenty je možné následne konvertovať na grafické objekty, napr. 

legendu, z ktorej sa stanú čiastkové objekty. Konvertovanie sa uskutočňuje v kontextovom 
menu k danému komponentu, kde vyberieme položku  Convert To Graphics. Pri prevode 
ostávajú niektoré komponenty zlúčené v skupine, preto je potrebné rozdeliť ich na samostat-
né objekty (  Ungroup).

8 .3 . Lišta Layout
Lišta s názvom Layout (Customize → Toolbars → Layout) ponúka spektrum základ-

ných nástrojov, ktorými vykonávame zmenu zobrazenia obsahu mapovej zostavy. Ide o po-
dobný súbor nástrojov (obrázok 109) ako pri lište základných nástrojov. Avšak nástroje lišty 
Layout sú viazané len na mapovú zostavu, resp. na zobrazenie vo forme Layout View. Záro-
veň je možné v tejto forme zobrazenia použiť (na úpravu zobrazenia obsahu dátového rámu) 
aj nástroje základnej lišty. Súčasne môžeme používať významovo rovnaké nástroje. Hlavným 
rozdielom je, že lištou Layout meníme zobrazenie len grafických a textových objektov. Teda 
takých objektov, ktoré nemajú geografické umiestnenie. Prakticky to znamená, že oddiale-
nie alebo priblíženie prvkov v dátovom ráme vykonáme v lište základných nástrojov. Oddia-
lenie a priblíženie mapového listu (mapovej zostavy), kde sú umiestnené grafické a textové 
objekty, vykonáme nástrojmi lišty Layout:

Obrázok 109

 •  Zoom In – priblíženie obsahu mapovej zostavy. Operáciu môžeme vykonať aj 
kombináciou klávesy „Z“. 

 •  Zoom Out – oddialenie obsahu mapovej zostavy. Operáciu môžeme vykonať aj 
kombináciou klávesy „X“. 
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 •  Pan – posúvanie zobrazeného obsahu mapovej zostavy. Operáciu môžeme vyko-
nať aj kombináciou klávesy „C“. 

 •  Zoom Whole Page – zobrazenie celého rozsahu mapovej zostavy. Operáciu môže-
me vykonať aj kombináciou klávesy „Insert“.

 •  Zoom to 100 % – mapová zostava v 100 % zobrazení (1 : 1).

 •  Fixed Zoom In – priblíženie s dôrazom na stred mapovej zostavy.

 •  Fixed Zoom Out – oddialenie s dôrazom na stred mapovej zostavy.

 •  Go Back to Extent – zobrazenie mapovej zostavy o krok späť.

 •  Go Forward to Extent – zobrazenie mapovej zostavy o krok dopredu.

Zoom To Percent  • – zobrazenie mapovej zostavy podľa zadaného percenta. V rozsahu 
od 0 % do 100 % pôjde o oddialenie a v rozsahu od 100 % do 1 000 % pôjde o priblí-
ženie obsahu mapovej zostavy.

 •  Toggle Draft Mode – prepnutie do tzv. „draft“ zobrazenia, t. j. návrhu rozmiestne-
nia prvkov bez zobrazenia obsahu dátového rámu.

 •  Focus Data Frame – výber dátového rámu, v ktorom môžeme pracovať rovnakým 
spôsobom ako v zobrazení Data View. Vložené grafické objekty sú viazané na geo-
grafickú polohu a ostávajú zobrazené v Data View, aj v Layout View. Ak by dátový 
rám nebol vybraný prostredníctvom Focus Data Frame, grafické a textové objekty 
by boli vložené na dátový rám, nie do jeho obsahu. Následne by boli tieto objekty 
zobrazované len v Layout View.

 •  Change Layout – zmena šablóny mapovej zostavy.

 •  Data Driven Pages Toolbar – otvorenie lišty s názvom Data Driven Pages, kde 
môžeme vytvárať mapovú zostavu vo forme viacerých strán, resp. viacerých mapo-
vých listov. 

8 .4 . Lišta Draw
 Lišta s názvom Draw ponúka nástroje určené na prácu s vektorovou grafikou. Nástrojmi 
vkladáme vektorové objekty do mapovej zostavy alebo dátového rámu, čím môžeme celkový 
dizajn mapového výstupu prispôsobiť našim požiadavkám. Objekty pomocou lišty Draw 
umiestňujeme v dvoch úrovniach:

grafické umiestnenie v zobrazení  • Layout View, t. j. objekty budú viditeľné len v ma-
povej zostave,
geografické umiestnenie v zobrazení  • Data View, t. j. objekty budú mať presnú geo-
grafickú polohu. Zároveň budú viditeľné v obidvoch formách zobrazenia.

Lištu Draw spustíme v položke hlavného menu Customize → Toolbars → Draw. Lišta je 
štruktúrovaná do niekoľkých častí.

Padajúce menu 1 . Drawing obsahuje nasledovné nástroje:
súbor nástrojov určených na prácu s anotáciami (1 .1 . New Annotation Group, Ac-
tive Annotation Group a Overflow Annotation);

1 .2 .  Group – viacero vybraných objektov zoskupíme do samostatnej skupiny;
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1 .3 .  Ungroup – rozdelenie skupiny objektov na samostatné objekty;
Graphic Operations1 .4 .  – úprava geometrie objektov, ktoré sú vo vzájomnom prie-
niku:
 •  Union – spájanie prekrývajúcich sa objektov do jedného útvaru,
 •  Intersect – z viacerých objektov sa vytvorí jeden prienikový objekt,
 •  Remove Overlap – odstránenie miesta vzájomného prieniku vybraných 

objektov,
 •  Substract – odpočítanie plochy objektu (prvý objekt v poradí výberu) 

z plochy zasiahnutého objektu (druhý objekt v poradí výberu);
1 .5 . Order – zmena vertikálneho poradia objektov, t. j. posun na inú úroveň:

 •  Bring to Front – na prvú (prednú) pozíciu,
 •  Send to Back – na poslednú úroveň,
 •  Bring Forward – o jednu úroveň dopredu,
 •  Send Backward – o jednu úroveň dozadu;

1 .6 . Nudge – posun objektu približne o 10 pixlov zvoleným smerom;

1 .7 . Align – zarovnanie objektu alebo objektov k zvolenému tlačovému okraju, a to 
k ľavému  Align Left, k horizontálnemu stredu  Align Center, k pravému  
Align Right, k vrchnému  Align Top, k vertikálnemu stredu  Align Vertical 
Center, k dolnému  Align Bottom;

1 .8 . Distribute – úprava objektov nástrojmi posunu, zmeny veľkosti a otáčania:
 •  Distribute Horizontally – horizontálne umiestnenie minimálne troch 

objektov o pomerovo rovnaký priestor medzi nimi tak, aby vzdialenosti me-
dzi nimi boli rovnaké. Poloha prvého a posledného prvku sa zachovala.

 •  Distribute Vertically – totožný nástroj s predchádzajúcim, len sa jedná 
o rozmiestnenie objektov vo vertikálnom smere.

 •  Make Same Size – vybraným objektom sa priradí rovnaká veľkosť podľa 
veľkosti prvého vybraného objektu.

 •  Make Same Width – vybraným objektom sa priradí rovnaká šírka podľa 
veľkosti prvého vybraného objektu.

 •  Make Same Height – vybraným objektom sa priradí rovnaká výška podľa 
veľkosti prvého vybraného objektu.

 •  Fit to Margins – prichytenie šírky a výšky objektu alebo objektov k tla-
čovým okrajom.

 •  Fit Width to Margins – prichytenie šírky objektu alebo objektov k tlačo-
vým okrajom.

 •  Fit Weight to Margins – prichytenie výšky objektu alebo objektov k tla-
čovým okrajom;

1 .9 . Rotate or Flip – nástroje otáčania objektov zvoleným smerom (doprava  Ro-
tate Right, doľava  Rotate Left) a prevracania, resp. zrkadlenia objektov (ho-
rizontálne  Flip Horizontally, vertikálne  Flip Vertically);
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1 .10 .  Convert Graphics to Features – konverzia grafických objektov na prv-
ky vrstiev geografických informácií. Nástroj je možné použiť len pre objekty 
umiestnené v prostredí dátového zobrazenia Data View;

1 .11 . Default Symbol Properties – možnosť zmeny predvoleného nastavenia fareb-
ných štýlov a typu písma grafických a textových objektov.

Skupina nástrojov výberu a transformácie:2 . 

2 .1 .  Select Elements – výber objektu alebo výber viacerých objektov. Po výbere sa 
zobrazia uzly, ktorými meníme veľkosti objektu. Zároveň je k vybraným objek-
tom možné zobraziť kontextové menu s nástrojmi rozšírených možností úprav. 
Ide o nástroje padajúceho menu Drawing, položky vystrihávania (  Cut), ko-
pírovania (  Copy) a mazania (  Delete), položky zmeny zobrazenia z lišty 
Layout a položky vlastnosti objektu (  Properties).

2 .2 .  Rotate – otáčanie vybraného objektu alebo objektov. Stlačením klávesy „A“ 
zobrazíme dialógové okno, do ktorého môžeme zadať hodnotu požadovaného 
uhla rotácie.

2 .3 .  Zoom To Selected Elements – priblíženie vybraných objektov.

Nástroje určené na vkladanie grafických a textových objektov.3 . 

Vkladanie grafických objektov v rozsahu: 3 .1 . 

 •  Rectangle – obdĺžnik, stlačením klávesy „Shift“ vložíme štvorec, 

 •  Polygon – mnohouholník,
 •  Circle – kruh, stlačením klávesy „A“ zobrazíme dialógové okno, kde mô-

žeme vložiť plochu alebo polomer,
 •  Ellipse – elipsa,
 •  Line – línia,
 •  Curve – krivka,
 •  FreeHand – útvar nakreslený voľným pohybom myši,
 •  Marker – bodová značka s rôznym symbologickým znázornením.

Dvojklikom na príslušný objekt sa zobrazí dialógové okno Properties, v ktorom 
môžeme meniť symbologické vlastnosti napr. farbu, veľkosť a umiestnenie dané-
ho objektu.

Vkladanie textových objektov v rozsahu: 3 .2 . 

 •  Text – jednoduché textové pole,

 •  Splined Text – text umiestnený na krivke,

 •  Label – popis podľa parametrov (Layer Properties → Labels) k danej 
vrstve, tento nástroj je možné použiť len v prostredí dátového zobrazenia 
Data View,

 •  Callout – rámik s voľným popisom a grafickým ukotvením,

 •  Polygon Text – polygónové textové pole,

 •  Rectangle Text – obdĺžnikové textové pole,
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 •  Circle Text – kruhové textové 
pole.

Nástroj 3 .3 .  Edit Vertices je určený na 
úpravu grafických a textových ob-
jektov. Pri textových objektoch ide 
hlavne o úpravu veľkosti textových 
polí a priebehu kriviek s umiestne-
ným textom pomocou nástroja  
Splined Text.

Súbor položiek (nástrojov) určených na 4 . 
formátovanie písma, t. j. výber typu pís-
ma, veľkosť a rez. Formát písma a sym-
bológiu textového poľa je možné upra-
vovať aj prostredníctvom kontextového 
menu textového objektu. Dialógové okno 
ponúka niekoľko záložiek (obrázok 110): 

 • Text – formátovanie textu, zarovnanie 
textu v textovom poli, natočenie tex-
tu, zmenu symbológie, odsekové na-
stavenia atď., Columns and Margins 
– počet stĺpcov a umiestnenie textu 
od okrajov textového poľa,

Area •  – štatistické ukazovatele vo vzťahu k zobrazovaciemu systému,

Frame •  – orámovanie textového poľa,

Size and Position •  – veľkosť a umiestnenie textového poľa.

Nástroje určené na farebnú úpravu písma (5 .  Font Color), vlastnosti výplne plošných 
objektov (  Fill Color), vlastnosti líniových objektov (  Line Color) a vlastnosti 
bodových symbolov (  Marker Color).

8 .5 . Lišta Data Driven Pages
Lišta s názvom Data Driven Pages (Customize → Toolbars → Data Driven Pages) po-

núka súbor nástrojov transferu jednej mapovej zostavy na sériu samostatných strán. Podľa 
zadanej indexovej vrstvy a zvoleného atribútu rozdelíme mapovú zostavu do samostatných 
strán resp. samostatných zostáv.

Každá mapová zostava môže obsahovať dve úrovne komponentov. Prvou úrovňou sú 
dynamické komponenty, ku ktorým patrí zobrazený geografický rozsah dátového rámu, 
mierka mapy, severka, dynamické texty pre každú zostavu (stranu) nezávisle. Druhou úrov-
ňou sú statické komponenty, ku ktorým sa radí veľkosť a orientácia strany dátového rámu 
a objektov vložených prostredníctvom lišty Draw. 

8 .6 . Popisy – Labels 
Ide o osobitný druh textových objektov, ktoré sa umiestňujú k vrstvám mapového doku-

mentu a sú viditeľné v obidvoch formách zobrazenia, t. j. Data View a Layout View. Umiest-

Obrázok 110
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ňovanie konkrétneho textu prebieha prostredníctvom zvoleného atribútu danej vrstvy, ktorý 
obsahuje požadovaný text. Popisy k prvkom vrstvy môžeme vkladať dvoma spôsobmi:

Automaticky1 .  – pomocou záložky Labels v dialógovom okne Layer Properties, ktoré 
zobrazíme k danej vrstve (obrázok 111). Na akékoľvek vytváranie popisov musíme 
mať vždy zapnutú voľbu vykonávania popisov (Label features in this layer). Ďal-
ší spôsob zapnutia popisov je priamo v kontextovom menu vrstvy (v okne obsahu) 
a v položke Label Features. Popisy k prvkom môžeme priradiť dvomi metódami. 
 • Label all the features the same way – umiestnenie popisov jednotným štýlom. 

V časti okna s názvom Text String je potrebné vybrať atribút, t. j. zdroj popisov. 
Define classes of features and label each class differently •  – umiestnenie popisov 
vo forme definovaných tried popisov. V každej triede sa môže nachádzať iný roz-
sah popisovania prvkov, ktorý definujeme SQL výrazmi. Ku každej triede popi-
sov priradíme inú symbologickú interpretáciu.
Nastavenie symbológie popisov (typ, farba, veľkosť a rez písma) sa realizuje v čas-
ti okna Text Symbol (pre obidve metódy popisov rovnako). Rozšírené symbolo-
gické možnosti ponúka tlačidlo Symbol. V časti okna s názvom Other Options 
máme k dispozícii dve tlačidlá. Prvým s názvom Placement Properties definu-
jeme umiestnenie popisov (horizontálne, vertikálne, vo vnútri prvkov, duplicity 
atď.) a riešenie konfliktov umiestnenia voči ostatným popisom a prvkom. Kon-
flikty umiestnenia popisov sa eliminujú váhovými kritériami a obalovými zóna-
mi. Tlačidlo Scale Range ponúka rozsah mierky na zobrazenie popisov. 

 
Obrázok 111

 
Obrázok 112

Manuálne2 .  – pomocou nástroja  Label lišty Draw. Tento nástroj je možné použiť 
len v zobrazení Data View a zapnutom označovaní popisov k danej vrstve (obrázok 
112). V záložke Label musíme špecifikovať atribút alebo triedy popisov rovnakým 
princípom ako pri automatickom vkladaní popisov. Kliknutím na nástroj  Label 
priradíme na konkrétnu vrstvu požadovaný popis.
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8 .7 . Tlač a export
Vytvorenú mapovú zostavu je možné tlačiť alebo uložiť do zvoleného grafického rastro-

vého formátu, napr. .jpg, .tif atď. 

Export realizujeme pomocou položky v hlavnom menu 1 . File → Export Map. V zo-
brazenom dialógovom okne Export Map môžeme podľa zvoleného súborového 
(rastrového) formátu meniť základné parametre, napr. pomer kompresie, rozlíšenie, 
bitovú hĺbku atď. Ide o formu exportu vo vzťahu k (exportovanému) tlačovému roz-
meru výsledného obrázka resp. mapy. 

V zobrazení 2 . Data View môžeme v položke Export využiť možnosť Write World File, 
ktorou k výslednému obrázku vytvárame aj georeferenčný súbor. Pri tomto expor-
te nie je možné do výsledného obrázka zahrnúť nami vložené mapové komponenty 
(názov mapy, legenda, mierka atď.). Exportujeme len rozsah aktuálneho zobrazenia, 
t. j. bez ďalšej úpravy v podobe mapovej zostavy. 

Tlač realizujeme položkou v hlavnom menu 3 . File →  Print. Zobrazené dialógové 
okno ponúka výber dostupných tlačiarní, kvalitu tlače (Fast – Normal – Best), roz-
sah tlače podľa zostavy Data Driven Pages, počet kópií a náhľad umiestnenia mapo-
vého listu k veľkosti papiera.

Otázky:

Aký je rozdiel medzi 1. Layout View a Data View?

V akom kontexte sa používajú vodiace línie – 2. Guides?

Aké možnosti ponúka dialógové okno 3. Data Frame Properties?

Ktoré formálne mapové prvky (komponenty) sa používajú pri tvorbe 4. 
mapových zostáv?

Aký je rozdiel medzi dynamickými a statickými objektmi – prvkami 5. 
mapových zostáv?

Aký účel má nástroj s názvom 6. Data Driven Pages?



87

Záver
ArcGIS predstavuje softvérový systém, ktorý umožňuje používateľom zhromažďovať, 

organizovať, riadiť, analyzovať a distribuovať geografické informácie. Je tvorený sériou rôz-
nych produktov prepojených do jedného pracovného prostredia. 

V kapitole s názvom „Práca s ArcMap“ sa používateľ naučí ovládať aplikáciu ArcMap 
ako hlavnú časť softvérového produktu ArcGIS Desktop 10.x. Aplikácia ArcMap umožňuje 
vytvárať geografické informácie, mapy, pracovať s databázovým rozhraním, priestorovými 
analýzami atď.

Kapitola s názvom „Práca s ArcCatalog“ je zameraná na predstavenie základnej prá-
ce s tzv. manažérom priestorových informácií. ArcCatalog spravuje geografické informácie 
v adresárovom priestore alebo v geodatabázach. Adresárovým priestorom je konkrétny disk 
alebo adresár, v ktorom sú uložené geografické informácie. Geodatabáza je podrobne štruk-
túrované prostredie na ukladanie geografických informácií. 

V kapitole s názvom „Tvorba a úprava geografických informácií“ sa používateľ oboznámi 
so základnými princípmi tvorby a úpravy geografických informácií pomocou lišty Editor. 
Táto lišta predstavuje súbor nástrojov tvorby, úpravy, kopírovania existujúcej geometrie, de-
lenia, spájania, zarovnávania, prichytávania prvkov geografických informácií. Lišta sa roz-
vetvuje na niekoľko ďalších líšt, samostatných menu, vyskakujúcich okien alebo na bočné 
panely.

Princípy práce s geografickou polohou sú popísané v kapitole s názvom „Transformá-
cia geografickej polohy“. Prostredníctvom kapitoly sa používateľ naučí geograficky správne 
umiestniť prvky geografických informácií alebo ich transformovať medzi kartografickými 
zobrazovacími systémami. 

Prehľad geoprocesingových operácií sa nachádza v kapitole s názvom „Geoprocesingové 
nástroje – ArcToolbox“. Geoprocesingové operácie predstavujú proces spracovania geogra-
fických informácií pomocou spektra nástrojov určených na správu, transformáciu a priesto-
rové analýzy geografických informácií.

Aplikácia ArcMap ponúka množstvo rôznych nástrojov práce s databázovým rozhraním, 
ktoré je viazané na vrstvy geografických informácií. Princípy práce s atribútovou tabuľkou 
sú rozpísané v rámci kapitoly s názvom „Práca s atribútovými hodnotami“. Kapitola je zame-
raná na prácu s atribútovými hodnotami (databázou údajov), na základe ktorých je možné 
vyhľadať a zobraziť prvky nachádzajúce sa vo vrstvách geografických informácií. 

V kapitole s názvom „Mapová zostava“ sa používateľ oboznámi so základnými nástrojmi, 
ktoré sa používajú na vytváranie mapových zostáv. Kapitola svojím obsahovým zameraním 
smeruje do oblasti kartografie, ktorá sa zaoberá zostavovaním mapových kompozícií.

Prostredníctvom spektra informácií, ktoré sa nachádzajú v predkladanej vysokoškolskej 
učebnici, používateľ získa zručnosť, schopnosť pracovať so softvérovým produktom ArcGIS 
for Desktop – ArcMap 10.x.
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Príloha  Technický popis k aplikácii ArcMap

Tabuľka 1  Súborové formáty v ArcGIS .shp

Typ súboru Súborová 
prípona Kde sa používa Popis

ArcMap 
dokument .mxd ArcMap

Obsahuje zoznam položiek okna obsahu, nastavenia 
zobrazovacieho systému, symbológiu prvkov, mapové 

zostavy a mnoho ďalších kompozičných nastavení, ktoré si 
používateľ zadefinoval pri práci s ArcMap.

Map package .mpk ArcMap a ArcGIS 
online

Mapový dokument s geodatabázou geografických 
informácií. Používa sa na šírenie vytvorených 

geografických informácií prostredníctvom ArcGIS online.

ArcGlobe 
document .3dd ArcGlobe

Súbor určený pre aplikáciu ArcGlobe, v ktorej sa 
nachádza zoznam zobrazených položiek a ďalšie súvisiace 
nastavenia. Ide o aplikáciu, ktorá je súčasťou 3D Analyst,  

t. j. rozšírenia ArcGIS.

ArcScene 
document .sxd ArcScene

Súbor obsahuje 3D scény, zoznam zobrazených vrstiev 
a súvisiace nastavenia. Ide o aplikáciu, ktorá je súčasťou 

3D Analyst, t. j. rozšírenia ArcGIS.

Service 
definition/draft .sd/.sddraft ArcGIS for Server Súbor z aplikácie ArcMap, používa sa na publikovanie 

produktov prostredníctvom ArcGIS for Server.

Layer file .lyr ArcMap ArcGlobe 
ArcScene ArcGIS

Súbor pravidiel na zobrazenie geografických informácií. 
Obsahuje len nastavenie zobrazovania a cestu k zdrojovým 

súborovým formátom vrstiev geografických informácií.

Layer package .lpk ArcMap ArcGlobe 
ArcScene ArcGIS 

Súbor pravidiel na zobrazenie geografických informácií 
s ich dátovým obsahom.

Address Locator 
file .loc ArcGIS Súborový formát sa používa na geokódovanie prvkov 

geografických informácií.

Toolbox .tbx
ArcGIS for 

Desktop a ArcGIS 
for Server

Geoprocesingové nástroje, ktoré rozširujú funkcionalitu 
ArcGISu.

Map projection 
file .prj ArcGIS Súbor, v ktorom sú uložené informácie o zobrazovacom 

systéme.

Geoprocessing 
and Python 

scripts
.py ArcGIS

Skript programovacieho jazyka Python. Používa sa 
na rozšírenie funkcionality a prispôsobenie ovládania 

ArcGISu.
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Tabuľka 2  Technický popis geodatabázy používanej v ArcGISe

Kľúčové 
vlastnosti ArcSDE geodatabase File geodatabase Personal geodatabase

Základný opis

Priestor na štruktúrované 
uloženie dátových súborov 
geografických informácií, 
ktoré majú medzi sebou 

relačné databázové 
prepojenie.

Dátové súbory geografických 
informácií, ktoré sú uložené 

resp. štruktúrované do 
jedného systémového 

adresára.

Geografické informácie, 
ktoré sú uložené resp. 

štruktúrované a spravované 
na báze platformy Microsoft 

Access.

Počet 
používateľov

Viacpoužívateľská databáza 
– multiuser, tzn. niekoľko 
súčasných zapisovateľov 

a čitateľov.

Jednopoužívateľská databáza – single user, tzn. jeden 
zapisovateľ a niekoľko čitateľov.

Platforma/
súborový formát

Oracle, Microsoft, SQL 
Server, IBM DB2, IBM 

Informix.

Systémový adresár 
štruktúrovaný na samostatné 

dátové súbory.

Súborový formát Microsoft 
Access (.mdb).

Veľkostný limit
Limit daný zo strany DBMS 

– Database management 
systems.

1 TB pre každý dátový súbor 
– dataset. 2 GB pre celú geodatabázu.

Typ operačného 
systému Ľubovoľná platforma. Ľubovoľná platforma. Microsoft Windows.

Bezpečnosť Zabezpečená zo strany 
DBMS.

Zabezpečená zo strany 
operačného systému.

Zabezpečená zo strany 
operačného systému.

Databázové 
nástroje

Nástroje DBMS na 
zálohovanie, obnovu, SQL 
podporu, bezpečnosť atď.

Nástroje operačného 
systému.

Nástroje operačného 
systému.

Poznámka

Široká škála využiteľnosti 
v systéme ArcGIS, hlavne 
pri práci s geografickými 

informáciami na báze 
serverových riešení.

Veľkosť geodatabázy je 
možné optimalizovať jej 

transferom do tzv. módu len 
na čítanie (read-only).

Často sa používa ako 
manažér atribútových 

záznamov.

Tabuľka 3  Charakteristika webových služieb

Skratka webovej služby Charakteristika

WMS (Web Map Service) Služba poskytujúca prenos dát v rastrovej, obrázkovej forme  
s mapovým obsahom.

WFS (Web Feature Service) Služba poskytujúca prenos dát vo vektorovej forme spolu  
s ich databázovým rozhraním.

WCS (Web Coverage Service) 

Služba poskytujúca rozšírený prístup k priestorovo umiestneným 
rastrovým údajovým sadám vo formáte coverage. Oproti WMS službe, 

ktorá poskytuje len statické georeferencované mapy, služba WCS ponúka 
dostupné údaje spoločne s ich popisom.
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Tabuľka 4  Súborový formát .shp

Súborová prípona Charakteristika

 .shp geometria prvkov

 .sbn priestorová indexácia prvkov

 .shx geometrická indexácia prvkov

 .dbf atribútová tabuľka vo formáte dBase IV

 .prj zobrazovací systém

 .xml metaúdajový súbor

Tabuľka 5  Všeobecné ovládanie aplikácie ArcMap

Klávesová skratka Príkazy

Z  Zoom In – priblíženie obsahu mapového okna

X  Zoom Out – oddialenie obsahu mapového okna

C  Pan – posúvanie obsahu mapového okna

B Continuous zoom/pan – priblíženie a oddialenie obsahu mapového okna v jeho 
strede

V Show vertices – zobrazenie všetkých uzlov prvku, na ktorom sa práve nachádzame

ESC Cancel – prerušenie

CTRL+Z  Undo – krok späť

CTRL+Y  Redo – krok dopredu

Tabuľka 6  Nástroje Edit Tool, Edit Vertices a Modify Edge

Klávesová skratka Príkazy

SHIFT výber viacerých prvkov alebo odstránenie prvku z výberu

N výber ďalšieho prvku

P  Sketch Properties – zobrazí sa okno v bočnom paneli s vlastnosťami jednotlivých 
uzlov

A  Add Vertex – pri stlačení klávesy „A“ a kliknutí na hranu prvku pridáme nový 
uzol

D  Delete Vertex – pri stlačení klávesy „D“ a kliknutí na uzol prvku odstránime daný 
uzol

BACKSPACE odstránenie vybraných uzlov

R zadanie polomeru oblúkových alebo kruhových geometrických útvarov

TAB zobrazenie lišty Edit Vertices alebo počas tvorby náčrtu lišty Feature Construction

SHIFT+TAB dočasné skrytie lišty Edit Vertices alebo lišty Feature Construction
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Tabuľka 7  Vytváranie línie a polygónu

Klávesová skratka Príkazy

CTRL + A Direction – definovanie smeru (v uhloch) na vytvorenie ďalšieho uzla

CTRL + L Length – definovanie vzdialenosti ďalšieho uzla od súčasného uzla

CTRL + D Delta X, Y – vytvorenie ďalšieho uzla na základe presne definovanej vzdialenosti od 
súčasného umiestnenia uzla

CTRL + G Direction/Length – vytvorenie ďalšieho uzla kombináciou smeru a dĺžky od súčas-
ného uzla

CTRL + P Parallel – na vytváranie ďalšieho uzla definujeme súbežný smer s hranou prvku, ku 
ktorému sme zobrazili kontextové menu

CTRL + E Perpendicular – ďalší uzol, resp. jeho smer, je kolmý na hranu prvku, ku ktorej sme 
zobrazili kontextové menu

F6 Absolute X, Y – vytvorenie ďalšieho uzla na základe presne definovaných súradníc 
X a Y

F7 Deflection – definovanie smeru (v uhloch) na vytvorenie ďalšieho uzla v nadväz-
nosti na polohu smeru predchádzajúceho uzla resp. hrany

F8 Streaming – pri voľnom pohybe myškou sa automaticky umiestňujú uzly. Vklada-
nie uzlov pomocou ľavého tlačidla myšky je vypnuté

CTRL + F5  End Snapping – prichytávanie na koncové uzly vytvorených prvkov

CTRL + F6  Vertext Snapping – prichytávanie na všetky uzly vytvorených prvkov vrátane 
koncového uzla

CTRL + F7  Midpoint Snapping – prichytávanie na stredový bod hrany vytvorených prv-
kov

CTRL + F8  Edge Snapping – prichytávanie na hrany vytvorených prvkov

CTRL + DELETE Delete Sketch – odstránenie vytváraného náčrtu

F2  Finish Sketch – ukončenie vytvárania náčrtu, čím docielime vytvorenie prvku

SHIFT + double-click Finish Part – ukončenie vytvárania časti náčrtu s možnosťou ďalšieho pokračova-
nia, napr. vnútorné výrezy alebo zmena tvaru prvku

WORLD FILE

Rastrové súborové formáty ERDAS IMAGINE, BIL, BIP, GeoTIFF atď. majú informácie 
o svojej geografickej polohe uložené v tzv. súborovom záhlaví. Podľa informácií o geografickej 
polohe dokáže príslušný softvérový produkt tieto obrázky presne geograficky umiestniť. 

Iný spôsob je ukladanie informácie o geografickej polohe do osobitného ASCII súboru, 
čo sa označuje ako „World File“ metóda. Ide o princíp dvoch súborov s rovnakým názvom 
a odlišnými príponami. Jeden súbor reprezentuje obrázok a druhý jeho geografické 
umiestnenie. Súborová prípona georeferenčného súboru je od rastrového súboru odlíšená 
zmenou jedného písmena na písmeno w. Od verzie ArcGIS 9.2 sa k prípone pridáva 
písmeno x.



96

Register

A
Absolute X, Y,  39, 95
Active,  16, 81
Add Basemap,  11
Add Control Points,  51
Add Data,  10, 11, 15, 52, 88
Add Vertex,  34, 94
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Auto Registration,  51

B
Bezier Curve Segment,  33
BILINEAR,  55
Bring Forward,  82
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91
Layout View,  10, 75, 76, 80, 81, 84, 86
Legend,  79, 91
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Rectify,  49
Related Tables,  19
Remove,  15, 41, 67, 70, 73, 74, 82
Remove Join(s),  73
Remove Overlap,  82
Repair Geometry,  63
Replace Geometry Tool,  44
Replace Sketch,  39
Reset Transformation,  50
Reshape Edge Tool,  46
Reshape Feature Tool,  36, 46
Right Angle,  34
Rotate or Flip,  82
Rotate Tool,  36, 91, 96
Rulers,  76

S
Save,  9, 15, 39, 67
Save A Copy,  9
Save As,  9, 15
Save As Layer File,  15
Save Edits,  39
Scale Bar,  80
Scale Text,  80
Segment Deflection,�  39
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Select All,  16, 35, 71
Select All Layers,  16
Select By Attributes,  19, 66, 74, 90
Select By Location,  69, 74, 90
Select Elements,  12, 83
Select Features,  12, 71
Select Link,  51
Select Topology,  46
Send Backward,  82
Send to Back,  82
Shapefile,�  26, 29
Shapefile Properties,�  29
Shared Features,  47
Side Type,  61
Sign In,  10, 24
S-JTSK Krovak EastNorth,  17
Sketch Properties,  35, 36, 94
Sketch Proportionately,  35
Smooth,  45, 47
Snap To Feature,  38
Snap to Sketch,  43
Sort Ascending,  19
Sort Descending,  19
Spatial Adjustment,  45, 47, 90
Spline,  50
Splined Text,  83, 84
Split,  36, 39, 44, 59, 90
Split Polygons,  44
Split Tool,  36
Square and Finish,  39
Start Editing,  31, 39, 43
Start Streaming To Log,  57
Statistics,  19, 71, 88
Stop Connection,  57
Stop Editing,  39
Straight Segment,  32
Streaming,  39, 57, 95
Súborová geodatabáza,  22
Substract,  82
Summarize,  19
Switch Selection,  19, 71
Symbology,  17, 88
Symmetrical Difference,  60

T
Table of Contens,  13, 14, 21, 88
Table Options,  19, 23

Tangent,  34, 39, 43
Tangent Curve,  39
Tangent Snapping,  43
Text,  78, 80, 83, 84, 85
Toggle Draft Mode,  81
Topology,  42, 43, 46, 47, 90
Topology Edit Tool,  46
Topology Edit Trace,  46
Trace,  34, 46, 91, 96
Transformation,  50, 54, 55
Trim Tool,  44, 46
Turn All Layers Off,  16
Turn All Layers On,  16

U
Ungroup,  80, 82
Union,  41, 60, 82, 90
Update,  49, 50, 61, 90
Update Display,  50
Update Georeferencing,  49
Up One Level,  24
Use Snapping,  42

V
Vertex Snapping,  42, 43, 95
Viewer,  13, 51
View Link Table,  51

W
WORLD FILE,  49, 96
Write World File,  86

Z
Zoom In,  12, 80, 81, 94
Zoom Out,  12, 80, 81, 94
Zoom To GPS Position,  57
Zoom To Layer,  15
Zoom To Selected Link,  51
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